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DoView Help

Welcome to DoView

Welcome to DoView 3.0 for PC and DoView for Mac 3.0. DoView is a new visual
approach to identifying your personal, program, project, or organizational results and
outcomes, showing the steps you are going to take to reach them, and working out how
you are going to measure whether or not you're on track to get the results you want.

DoView: Think. View. Plan. Share. See. Evaluate. Monitor.

DoView is a new innovative stand-alone piece of software which will radically simplify your
work with outcomes (think of it as the world's first true ‘outcomes processor’). We all
have to be accountable for results and outcomes and DoView lets you quickly produce
visual models of the outcomes you are trying to achieve and the steps you are using to
get to them. Such visual models go by many names such as: outcomes models, results
models, strategy maps, logic models, intervention logics, theories of change, program
theories, ends-means diagrams and results roadmaps. DoView has been designed to
help you build them fast and share them with others. It is used for talking about outcomes
in strategic planning, evidence-based practice, program evaluation, monitoring, and
outcomes-focused contracting.

DoView makes working with outcomes a breeze. All the tools you need are at your
fingertips in a single simple intuitive environment, and the program handles all the
technical aspects of the process for you. Instead of wasting countless hours trying to
draw and format your outcomes and the links between them, you can focus all your
energy on the content of your planning, so that all your working time is productive time.

DoView's power and user-friendliness brings a new dimension to your work. We created
DoView to meet the day-to-day challenges and frustrations faced by those who need to
not only plan, but regularly communicate, amend and share a visual plan of the outcomes
they are seeking with real people. People who want to quickly understand what you are
trying to do and how you are planning to do it. We know of no other outcomes modeling,
logic modeling and visual planning tool available that just the features you need in such an
affordable user-friendly package.

? If you want to get started with DoView right away go to the Quick Start Tutorials. (Help>
Quick Start Video Tours)

Intuitive working environment

DoView's working environment gives you what you need to quickly build a visual
outcomes model without the complexity and confusing redundant features of full-on
drawing programs. This is combined with powerful time-saving features for editing plans
that are so easy to use. It has also been optimized to help you build plans in real-time in
front of stakeholder meetings.

Generate HTML, PDF and poster versions

Once you've build your model, DoView lets you quickly generate web page models and
PDFs of your model. The PDFs can range normal sized paper versions up to poster-
sized versions.
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The web page model output includes a full menu structure that emulates the appearance
and functionality of DoView and can include a downloadable DoView or PDF file. The
ability to download the DoView file which created the web page version means that you
have a way of rapidly spreading your models to others who may want to use them.

Images and whole pages of your DoView files can be added to your email, word
processing or other files with simple copying and pasting of single DoView pages (
Copying pages).

[DoView 3.0 7 June 2011]
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2 Getting started

The topics in this section provide some basic information about DoView, what it is for and what you
can do with it.

How to get started
Look at DoView screen section to quickly become familiar with how DoView works.
Examples of use shows lots of different ways you can use DoView.

Work through the Quick Start Video Tours (Help>Quick Start Video Tours) to familiarize yourself
with using DoView.

Study the Commands & features summary section for helpful detail about using DoView's
commands and features.

Learning more

See the Installation & technical section for practical answers to questions you might have on
installation, specifications and technical information on DoView file types.

Are you using DoView to build logic models or other types of outcomes models? See Building
outcomes models for suggestions and tips that will save you time and help you get the most out of
DoView.

You can print and view this help documentation in PDF format from the DoView website www.doview.
com/resources.html.

Help Version 3.0 10 June 2011
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3 The DoView approach

DoView allows you to work in a much more flexible way when thinking about and identifying the
results and outcomes you are trying to achieve. It has been specifically designed to allow you to
quickly build what are called outcomes models (program logics, project models, strategy maps,
program theories, theories of change, results chains, simple cause-effect models, etc). Outcomes
models are becoming a standard way of providing a visual representation of the results and
outcomes you are trying to achieve personally, in a project, organization or sector.

The DoView Approach

The DoView approach is for you to have a comprehensive outcomes model which underpins your
project, program or organization's work. The same outcomes model can be used for strategic
planning, priority setting, monitoring, evaluation, research and development planning, outcomes-
focused contracting and other aspects of organizational life. Using the same \isualized outcomes
model for some, or all, of these purposes increases organizational, project or program alignment to
achieving your outcomes. Using the DoView approach also means you save time - you no longer
have to rework the same material relating to outcomes, strategy and performance management in
different formats (e.g. a strategic plan in one format, performance monitoring and evaluation in
another, outcomes-focused contracting specification in another etc.).

Using the DoView approach means working with DoView which will help you:

¢ Visualize even large outcomes models clearly and without clutter

Store additional information relating to outcomes and the links between them

Quickly navigate around your model

e Use your model in real-time in all meetings and discussions about strategy, priorities, monitoring,
evaluation, contracting etc.

e Leweraging the work you have done on building your model for a range of organizational functions.

DoView is very simple to use in real-time and has been optimized for use on a data projector in a
medium-sized meeting. See the Using DoView in meetings Section. You can print your model as a
PDEF file (either letter/A4 or a range of different paper sizes up to large-sized posters). Or you can
produce a web page models and then put it up on the internet so that people can see it there.

DoView takes a generic approach to working with outcomes

There is a wide variety of terminology used throughout the world when people are working with
outcomes (outcomes, results, objectives, key priorities, key drivers, activities, outputs, processes,
inputs etc.). DoView does not ‘hard-wire' in one particular terminology and instead just talks in terms
of high-level outcomes and steps. This means that it can be used for modeling outcomes in any
situation where one is working with outcomes or results-based approaches.

Examples

For examples of use, see the Examples of Use Section. Uses include: outcomes models, program
logics, project outcomes, strategic planning, strategy maps, outcomes models. In addition, DoView
is flexible enough to be used for a range of other purposes such as stakeholder plans, SWOT*
analyses and building full visual monitoring and evaluation plans.

*Strengths, Weaknesses, Opportunities and Threats analyses used in strategic planning.
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4 Changes to Version 3.0

Always make sure that you have the most up-to-date version of DoView installed on your computer
(To find out which version of DoView you hawe, click on Help > About in the main menu at the top of
the screen in DoView). To update DoView go to http://www.doview.com/update.html. Version 3.0 is a
no cost upgrade for registered users, in includes important new features which have been suggested
by DoView users. They are:

¢ Doview for Mac 3.0 - DoView can now be used on either a Mac or a PC and files made on either
type of computer can be exchanged and edited on either type of computer.

e Better quality PDFs.

¢ A new Designer palette of colors and a color picker which allows any color to be selected. The
original Dataprojector optimized palette is still available. It uses a set of colors which have been
optimized for use on a dataprojector screen. However a wider range of colors is how available.

e Most objects and parts of objects can now be colored (e.g. text, borders, fill, links).

e Traffic lights can be inserted to show the status of step boxes.

¢ Link lines can be made thicker.

¢ Objects can be locked in position on the screen.

¢ A resizable arrow can now be inserted anywhere in on a DoView page.

e Watermarks of different shapes can be put on boxes. This is a better way of allowing boxes to be
differentiated by shape rather than just using shapes in DoView models because some shapes are
very uneconomical in terms of the amount of text that can be fitted into them (e.g. triangles).

¢ Information in the Details Table can be exported to CVS format which can then be read by Execl.

e Step boxes can be linked and unlinked by dragging out from the blue handle in the middle of a
box, this makes working with links much faster.

e The contents of a page can be copied from a Right-Click on a page name and then pasted onto a
new page. This is more efficient than having to select and copy the contents of a page before
pasting them on a new page.

If you have a registered earlier version of DoView you can update to Version3.0 or to DoView for Mac
3.0 for free. Just uninstall your current version of DoView and then go to www.doview.com/update.
html. Your registration serial number will carry over so the new version will be automatically
registered if you are using a PC. If you are using a Mac and have a registration serial number you
can just enter that into the Mac version.
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5 DoView screen

The DoView screen includes the following areas:

The main page window area - the place in the middle of the screen where pages (diagrams) open
one at a time.

The toolbar - a set of commonly used tools running along the top of the screen.

The page list - down the right-hand side of the screen, it lists all of the pages (diagrams) in the your
model.

The details table - runs along the bottom of the screen, each row contains additional information
associated with some of the objects you put on a DoView page (diagram).
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6 Commands and features summary

This 'Commands and Features' section provides detailed information on DoView's commands and
feature as follows:

Pages - ‘'diagrams' on which outcomes models are drawn in DoView. There are two sizes of these
compact and large.

Page sizes - various sized pages you can create.

Objects - of various types which you can put on pages (steps, text, groups, rule-lines, indicators,
questions, items).

Toolbar - runs along the top of the screen and includes commonly used commands.

Page list - runs down right-hand side of the screen and provides a list of all the pages in your model.
Details table - runs along the bottom of the screen and its rows are associated with some DoView
objects (steps, items etc.)

Steps - boxes which you put on pages which stand for outcomes, causes, effects, outputs, activities
etc.

Links - cause effect relationships between steps.

Links and drawn lines - using Link tool to draw line and arrows to show cause and effect
relationships between steps.

Views for links and lines - using the View menu to determine which type of links and drawn lines and
arrows are shown.

Link lines - arranging - arranging line and arrow links on a page by dragging their link boxes.

Clones - 'live copies' of a steps, groups, indicators, questions, items which are all amended if one is
amended.

Page-jump - hyperlink which takes you (‘hops' you) to another page (makes it come up in the main
page window).

Zoom - zoom to fit makes the page being viewed fit within the area of the main page window and
zoom to actual returns it to its actual size.

Pan - lets you mowe a large page around within the main page window so you can view an area of it.
Drill-down - right-click command from a step which creates a new page containing a clone of the
step and sets relevant page-jumps.

Text - text object is a piece of text which can be put on a page and resized to small, medium or
large.

Groups - rectangular box drawn around other objects to visually group them.

Rule-line - dashed horizontal line running across a page.

Indicators - indicator icon with a name for identifying ways of measuring steps.

Questions - question icon identifying an evaluation, research or other questions about steps or other
objects on a page.

ltems - an item icon and a name identifying any other type of entity you want to put on a page
(project, person, organization, thing etc.)

Pictures - inserting a picture into a step or onto a page.

Adjust - aligning and resizing objects (steps etc) on a page.

Folders - heading in a page list for organizing pages.

Direction pointer - inserting an arrow to show the direction of the model.

Rows - line in the details table associated with some DoView objects.

Fields - exist within a row for putting different types of information on the associated object (name,
description, notes, working notes).

Elag - orange block of color on the left hand end of a row which you can turn on and off to draw
attention to the row and its associated object.

Rotate - right-click command from a step (or certain other objects) which turns the object on its side.
Show details/fields - allows one field at a time from a row in the details table to be displayed on a
page under its associated object.

Copying pages - copying pages for pasting within DoView or for pasting to outside software.

© 2007-2011 The Ideas Web Ltd
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Pages, copying between models - copying and pasting pages between DoView files.

Model/file - the name for all of the pages in a DoView file.

Multiple instances of DoView - having more than one instance of DoView running at a time.

Printing as PDE - how to print pages and their details table information to a PDF file for emailing or
printing out a model.

Import-Export - options for getting information in and out of DoView.

Web page models (creating) - how to create a web page model of all of the pages (pages) in a
DoView model for putting up on an intranet or the internet.

Web page models (using) - how to use a web page model when viewing it in a browser on an intranet
or the internet.

Hyperlinks (inserting) - how to insert hyperlinks onto a page (page).

© 2007-2011 The Ideas Web Ltd
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DoView Help

Toolbar

The toolbar runs along the top of the DoView screen. It contains commonly used commands. You
can use the toolbar to insert some objects (a step, link, group, text) onto a page by clicking on the
object button (tool) in the Tool Bar and then clicking on any blank area of the main page window,
where you want that object to appear. The left-hand side of the Tool Bar has the following icons:

File Edit Wew Help

@ = BH H e =H A A

Back  Forward Cpen Save ndo Step Link Group Text

Back - goes back one page (as in a nhormal Browser).

Forward - goes forward one page (as in a normal Browser).

Open - opens a model (file).

Save - sawves any changes in the currently open model (file).

Undo - undoes your last command (will not undo all commands e.g. delete page).

Step - inserts a step onto a page (click on the tool, then mowve to where you want the step to go on
the page and click again).

Link - inserts a link between steps onto a page (click on the tool, then mowve over the step you want
to link from, click once and hold down your left mouse button while you drag the arrow which
appears over the step you want to link to, then let go of your mouse button). The link tool can be in
one of a number of modes, selected using the small black down arrow on the right-hand side of the
Link tool (see Links and Links and Drawn Lines)

Group - inserts a group box with space for a group title around objects on a page (click on the tool,
then mowve to where you want to put the group on the page, click again and drag the group box out to
the size you want it).

Text - inserts text onto a page (click on the tool, then mowve to where you want the text to go on the
page, click again).

The right-hand side of the Tool Bar has the following icons:

2 @ @ @ @ [T ]¢ &

Fan Artual Size Zoom to Fit Zoom In Zoom Qut Show Page List

Pan - lets you pan (mowe) around a large page around so you can view it in the main page window.
Actual size - lets you see the page the actual real size it is in the main page widnow.

Zoom to Fit - lets you zoom out a page in the page viewing so that you can see all of it at once if it
is larger than the main page window. This is particularly useful for large pages.

Zoom in - lets you zoom in.

Zoom out - lets you zoom out.

Redo - redoes your last command (will not redo all commands).

Show page list - opens and closes the page list.

Previous - takes you to the previous page in the page list.

Next - takes you to the next page in the page list.

Version 1.02 and earlier of DoView included a Copy Page tool in the tool bar, from version 1.03
onwards this has been replaced with the ability to copy with a Right-click > Copy when selecting a
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8 Pages

A page in DoView can contain a variety of Objects (steps, indicators, text etc), it can be various
sizes. The page size is set when the page is created.

Pages are viewed in the main page window. A DoView model (file) is made up of a number of pages.
All the pages in a DoView model are listed in the page list. You move between pages (page-jump
between them) by: 1) clicking on the page you want to see in the page list; or 2) by clicking on a
page-jump which has been set within a step, text object, indicator, question or item.

Dolew
Se it yen b

Hurj ]i-i-L-A Z 8 @ @ Q

Open i Gap  Test Pan  AchalSae ZoomtoFt Zoomln Zoom Out Show Page List

'Main page window' e

Pages are viewed
Page list

here one at a time

Page list Tool Bar

T
»| MewixiPage  NewFuder DeletePoge

D Type Fiag Name Descripton Hotes Wiorking Nates

A page is create by clicking on New Page in the Small Page List Tool Bar at the bottom of the page list
(on the right-hand side of the screen). A page is deleted by clicking on Delete Page.

Pages have a small color block on their left-hand side. The color of this can be set by doing a Right-
click > color on the page name.

The small Page List Tool Bar which is at the bottom of the Page List is shown below. The New Page
button contains the size of the page which is about to be created. Clicking on the small down arrow
to the right of the New page button, firstly provides a list of the page sizes already included in the
model. Secondly, other sized pages can be created by selecting Other sizes...

DoView models can include the standard compact 1 x1 default page size or many other page sizes
up to large poster sizes. See details in the section on Page sizes. Many page sizes in DoView are
specified in terms of the number of compact 1 x 1 pages you can fit onto the page. For instance, a 2
x 2 page will fit two ‘columns’ and two ‘rows' of compact 1 x 1 pages (i.e. four 1 x1 pages in total). If
you wish, you can firstly build your outcomes model with compact pages (which means that you can
always work with them when dataprojected and print them on normal sizes paper) and then clone
them all onto one or more large pages for printing as posters to Ledger/A3 or larger sizes using Print
as PDFE. For more information see the Section on Why You Should Use Compact Pages.
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Other sizes...

To rename, copy/paste or delete a page, do a right click on the page name.

For copying pages see the Section: Copying Pages. For copying pages between instances of
DoView see the Section: Pages. copying between models.

A picture can be added to a page by:

¢ Boing to a blank area of a page and doing a Right-click > Picture and then choosing the picture you
wish to insert; or

¢ Pushing Alt 4 and then choosing the picture you wish to insert; or

¢ By copying an existing picture within DoView (Right-click > Copy) and pasting it (go to a blank area
of a page and do a Right-click > Paste).
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Page list

The Page List is part of the DoView screen, it runs down the right-hand side of the screen. It contains
a list of all of the pages (diagrams) in the DoView model (file) you are currently working on.

Pages can be nested under other pages by dragging. Eolders can be created in the page list.
Folders are not pages themselves, but pages can also be nested under folders.

Pages and folders are created by clicking on New Page in the small Page List Tool Bar at the bottom of
the Page List. Pages and folders are deleted using the Delete Page command in this tool bar.

Pages hawe a name, an automatically allocated color represented by the small colored block to the
left of the page name in the page list, and a sequential number on the right hand side. The page
number changes as pages are added, deleted, and dragged and rearranged in the page list.

Pages can be copied and pasted within an instance of DoView and between instances of DoView.
See the Section: Copying pages and Pages, copying between models.

On the Tool Bar, clicking on Show page list opens and closes the Page List. .

i

Page List

Pan

' Opens and closes
2 Q [
H-:t'ual Size Zoom to Fi Show Page List

Selecting a page name or folder name in the Page List and doing a Right-click > Copy will allow you
to copy and paste the page within the current file, to another DoView file. Doing a Right-click > Copy
asimage will let you paste it into outside software (such as Word, Powerpoint or Outlook). See the

Section: Copying pages.
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Objects put on a page
A number of objects can be placed onto a DoView page (diagram). These are:

Basic objects: (these can be put on a page by right-clicking on a blank area of a page and selecting
them from the right-click menu)

Step- Steps are boxes that can be put on a DoView page. They can stand for causes at any levels
within an outcomes model (often just called outcomes). Steps have rows associated with them in
the details table.

Text- Text can be put onto a DoView page. It can be resized (Right-click > Format > Font size to small,
medium or large or larger sizes. Large text can be used for headings. Text does not have a row
associated with it in the details table.

Picture - Pictures can include graphs, photographs or other types of images. They can be added to
a page and to a Step. Pictures do not have a row associated with them in the details table.

Group - Groups are simply boxes that can be put around other objects to show that they are
visually grouped. Groups do not lock together any objects placed inside them. Groups do have a
row associated with them in the details table.

Rule line - Rule lines are simply lines (either dashed or solid) that run horizontally or vertically
across a page. They can be used to visually mark lewvels between elements on a page or for any
other purpose. They can be rotated (Right-mouse dick > rotate) to be vertical. Rule lines do not have a
row associated with them in the details table.

Web hyperlink - Hyperlinks are any external hyperlinks out to any web address on an intranet or
the internet. They can be used to link to any material which is relevant to a part of a DoView page.
They could even be used to link out to other web page models of DoView files which have been put
up on an intranet or the internet.

Local file links - Links out to local files (e.g. Word, Powerpoint, Excell) on your own computer
which you can use to document various parts of your model.

Direction pointer - the direction pointer is simply a arrow which is used to show whether the model
direction is Bottom-to-Top or Left-to-Right.

Advanced objects: (these can be put on a page by right-clicking on a blank area of a page,
selecting Advanced and selecting the object you want).

Indicator - Indicators consist of an indicator icon (small yellow icon) and an indicator name.
Indicators are used to place the name of measures of outcomes (steps) onto a page. Indicators do
have a row associated with them in the details table.

Question - Questions consist of a question icon (small green circle with a question mark in the
middle) and a question name. Questions are used to put questions onto a page that may be related
to particular steps (outcomes). Questions can be used for any type of question you may have about
your model, but are often are used for evaluation and research questions. Questions have a row
associated with them in the details table.

Item - ltems consist of an item icon (small grey square) and a name. ltems are generic objects
which can be used for a range of purposes, for instance, to stand for projects, people, organization
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or things etc. Items have a row associated with them in the details table.

Direction pointer - the direction pointer is simply a arrow which is used to show whether the model
direction is Bottom-to-Top or Left-to-Right.

‘ Text heading (large size)
Group 1
@ Indicater 1
Eérientc;i;:un f SlEi ﬁ f e W @ Question 1
L ) L ) | Mitem 1
Rule lines

Insered
picture

'Objects’ that can be put on a page
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11  Steps

Steps are boxes which are one of the several types of objects which can be put onto a DoView page
. They can be used to stand for causes or effects (outcomes, outputs, activities, tasks, key drivers
etc) which are put into outcomes models at various levels. One of the great things about DoView is
that it is generic, it lets you work with steps which may be called by different names in your
particular outcomes system, but it does not 'hard-wire' in any particular terminology.

This is a step This is a cloned This is a step This is a cloned | This is a selected This is a colored
step with a hop-to set step argup step

[

A step is put on a page by:

¢ Double clicking on any blank area of a page, or

¢ Clicking on the Step tool in the toolbar and then clicking on the place on the page where you want
the step to go, or

e Going to a blank area of the page and doing a Right-click > Step

e Pushing Alt 1

e For rapid step entry, by selecting a step, holding down Ctrl and pushing one of the four arrow
keys. This will create a new step in the direction of the arrow key each time you push it, or

e Copying an existing step (Right-click > Copy) and pasting it (going to a blank area of the page and
doing a Right-click > Paste).

You can change the shape of a step by: dragging the small green squares in the four corners.

Steps have rows associated with them in the details table as shown below:

o) Type ‘ Flag | Marme ‘ Descripkion ‘ Mates | Working Motes
8

O Thisisastep A description of the step  Mates about the step  Less Formal working notes about the step

A step can also be pasted as a clone - a live copy' with a shadow of the step down one side as
below (Right-click>Copy then Right-click>Paste as clone where you want it). The nhame, details table
information and links of a step's other clones (if it has any) are updated whenever these aspects of
step change step is updated. The shape, size and color of clones of the same step can be differ.

This is a cloned
step

Inserting a picture into a step

You can insert a picture into a step by:

e Pasting it in from the clipboard.

¢ selecting (or creating) the step into which you are wanting to put a picture and then doing a Right-
click > Picture > Choose Picture and choosing the picture you wish to insert.

Do not infringe copyright, make sure you have the right to include any picture you put in a model.

When adding a picture to a step you can choose how your picture will appear. The three options
are:

e Standard shape - this is a shape optimized for appearing in a rectangular step
e Cropped border - this uses the standard shape and crops and slightly zooms the picture,
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making the central detail easier to see
e Original shape - this keeps the original shape of the picture.

When inserting the picture, you can decide whether or not you want to include a larger copy of the
picture in the file - so that you can enlarge it if you wish when viewing the model (e.g. to make a
point to your audience). If included the larger version of the picture will also be available in any web
page version of the models you create when a user clicks on the picture in the web page model. If
you do not want to include the picture just check the box Reduce file size; do not include a larger
copy in this step's details.

-

#* Choose a picture shape

Reduce file size; do not indude a larger copy in this step's details

Lize this Choose another

[ Cancel

To see a large version of the picture at any time do a Right-mouse click > Show enlarged picture. In a
web page version of a model when you click on a the picture within a step, it will be enlarged.

Positioning the picture within the step

The position of the picture within a step is firstly determined by the model direction mode when the
picture is first inserted into the step. When DoView is in a Bottom-to-Top model direction mode,
pictures are inserted in a step to the right of the text in the step. When in the Left-to-Right model
direction mode, pictures are inserted into a step abowve the text. The position of a picture within a
step can be changed at any time by a Right-mouse dick > Picture > Position.
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'S Bt

The name of the
step goesin
here

The name of

thei Edit Details...

& This appears on 3
Rotate F
Copy

Delete

This makes happen
This is the result of
Change color

v v v

Farmat

Show Picture

Flace to the right of text
Place above text

Drill down to new page 3

Remove picture

Set page jump... Hide Picure

Hiding a picture in a clone

If you are working with a clone of a step which has a picture in it, you can hide the picture with a
Right-mouse click > Picture > Hide Picture just in that clone version (the picture can still appear
in other clones and can be turned on again if you wish in this clone.

Deleting a picture
You can delete a picture at any time from a step with a Right-mouse click > Picture > Delete picture.
This will delete also permanently delete it from any clones of that step which exist.
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12 Page-jump

A page-jump is a small triangle in the bottom right-hand corner of a step, text element, indicator,
question, web or file hyperlink or item. It works like a hyperlink in a browser but just moves you
between pages within a DoView model or a DoView web page model. Clicking on a page-jump will
mowve you to the page to which the page-jump for that step or other object has been set.

To set a page-jump for a step, text object, indicator, question, web or file web or file hyperlink or item
: Right-click > Set page-jump, now select the page you want to be able to page-jump to, from the list of
pages you are presented with. If there are clones of the step or other object, the pages on which
these appear will be listed first.

Page-jumps take on the color of the small color block to the left of the name of the page to which
you will jump. See the example below.

7Z @ @ @ Q |4 | .

Pan Actual Size Zoom to Fit Zoom In  Zoom Cut Show Page List

—
F Y

|— | |Page List

Page One 1
Page Twp
step 1 Page Three
Fage Four

~ 4 Page Five

[0, TR O PR

T

Page 5iz
B Page Seven
Fage Eight

I

LY R ]

Page Mine

Creating a stand-alone page-jump

A stand-alone page-jump can be created by inserting a text object, entering a little text into the text
object, creating the page-jump (Right-click > Set page-jump) and then deleting any text from the text
object.

See also: Drill-down.
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13 Drill-down

In DoView you can quickly 'drill-down' beneath a step, group,indicator, question, item, or web or file
hyperlink.

You do this with a Right-click > Drill down to new page. This will create a new page (you will be able to
see the new page which has been created appear in the page list. The new page will have the same
name as the object from which you are drilling-down. So in the example below, the new page would
be called Step 1. The new page will contain a clone of the object from which you drill-down. A page-
jump will be inserted into both the object you drilled-down from and the clone of it on the new page
which is created.

Edit Details. ..
This appears an 3
Rotate ]
Copy

Delete

This makes happen
This is the result of
Change colar
Format

Picture

v v v w v

Crill down to new page 3
Set page jump...

When you drill-down to a new page you can select the size of the page you want created on the drill-
down. You can select the standard compact 1 x1 page size, or one of the page sizes already
existing in the model, or use Other sizes... to select a page size not yet in the model.

This is the result of 3
Chan 3
Form, 3
Pictur 3
= = - Same Size
Set page jump...
page jump %1
22
45
Other sizes. ..
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14 Links

Links can only be made between steps. One of the unique things about DoView is the DoView link
icon which records a link ewven if a line and arrow has not been put in. Once a step is linked to
another step, whenewer you select the step, the DoView link icons show any other steps it makes
happen (it causes) and which steps it is the result of. In addition, whenever you wish, you can add a
drawn either a straight line or a bent line to also visually represent a link.

| Step 3
( '|s the result of
icon
I Fa¥
Step 2
5]
Step 1 makes Step 'Makes happen' icon
2 happen (cause)
and Step 3 is the L
result of Step 2 Step 1

(effect)

Note that when in View > Model Direction > Left-to-Right mode, the DoView link icons will appear on
the left and right sides of a step box rather than the top and bottom.

Tip: It is not possible to have a drawn line without also having an underlying DoView link. However,
you can have an underlying DoView link without having it also represented by a drawn line.

You should read the rest of this section for information on links and then read the Section on Links
and Drawn Lines for information about how you can also represent links with drawn lines.

Make links by:

¢ Clicking on a step, left-mouse clicking on the small blue box in the middle of the step, holding
your mouse down, dragging it over a second step which you want to link to and then releasing the
mouse button when the DoView link icon (see screenshot below) appears on the bottom edge (or
left side) of the second step

¢ Clicking on the link tool in the toolbar and following the rest of the instructions above

¢ Holding down Alt when you have a step selected and dragging out over any other step.

You can make multiple links by:

¢ Clicking on the small arrow to the right of the Link Tool on the Tool Bar and selecting Make many
links at once. This will allow you to make as many links as you like to other steps. When you have
finished making your links you can turn this function off by: 1) re-clicking on the Link Tool; 2)
Right-mouse clicking; or 3) pushing Esc.

¢ Holding down Alt when you have a step selected and dragging out over any other step also means
you can make multiple links.

Make reverse links by:
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¢ Holding down Shift when you are making links using the methods listed abowe. e.g. by holding
down Alt Shift.

¢ Clicking on the small arrow to the right of the Link Tool on the Tool Bar and selecting Make many
reverse links at once.

Making links across pages hy:

e Selecting a step, going to the other page on which the step to which you wish to link it is located
and holding down Alt.

¢ Clicking on the row in the details table for the step from which you wish to make a link and holding
down Alt.

¢ Clicking on the Link Tool in the Tool Bar instead of holding down Alt.

Deleting a link
¢ Redraging a link will delete it. The DoView link icon will flash red for a moment.

Tip: When making links across pages, if you make a link by mistake use Undo (e.g. Ctrl Z) to
remowe it and then continue on with your linking.

[ |

i

u—'T'—u - A f:—

Link Group Text Fa
Insert Link only

* Insert Link, and draw straight line

Insert Link, and draw bent line

Make many links at once
Make many reverse links at once

Options available when clicking on
the small arrow next to the Link
Tool on the Tool Bar

The DoView link icon

The DoView link icon is only shown for one step at a time in DoView - when you click on a step
which is linked to any other step the link icons appear. This keeps diagrams uncluttered.

Howewer, you can, if you wish, also represent links with drawn lines (see the Section on Links and

Drawn Lines). This means that you can show the links between a number of steps on a page. This

can be useful when printing out pages using print as PDF. In addition, when you print as PDF you
can select the option of including information from the details table, which will put a list of all steps
and their links at the end of the PDF. You can also click on a step prior to printing as PDF and the
PDF will include exactly what can be seen within DoView - so if there are DoView link icons
showing, these will also be showing in the PDF.

Tip: If you select a first step and move to another page without unselecting it, any steps on the new
page which are linked to the first step will show the appropriate DoView link icon. The same applies
if you click on any step name in the details table.

In the example below, Step 1 has been linked to Outcome 2 and Outcome 3 and so when Step 1 is
selected the is a result of link icon will appear on Outcome 2 and Outcome 3.
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Any step can be connected to any other on a slice

Cutcome 1 CQutcome 2 Qutcome 3
FaX VAN

=
Step 1

Copyright 2007. DoViewcom model.

Selecting a step, right clicking and selecting either This makes happen or Thisisaresult of, will list all
of the steps in the model (no matter what page they are on) to which the selected step is linked.

Edit Details. ..

i = This appears on 3
Rotate

Copy

Delete

This makes happen »

A 0 Page Two &
Change color 'Step D' »
'Step F' b
'Step G 3

-

Faormat
Picture

- v

Crill down to new page 2

Set page jump...

Storing additional information about links in the details table

Links have rows associated with them in the details table as in the screenshot below. You can
access the information in the row by either clicking on the row when you have selected the link on a
DoView page (the row for the link will be highlighted in blue), or just by double clicking on the link
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itself.

jin] | Tvpe | Flag | Mame | Description | Motes | Warking Notes

125 ) Step One » Step Two A description of the link  Motes about the link. Less formal waorking notes about the link

Hyperlinking out to additional information related to a link

You may want to hyperlink out to an external web address (URL) or to a local file with further
information about a link. For instance, it may be a summary of evidence on a web page (either one
someone else has put up or one you have put up) which supports the existence of the link you have
made. You can put a link out to the web or a file on the page which, when clicked on, will take the
user out to the relevant web page or local file.
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Links and drawn lines

Where there are DoView links between steps, you also have the option of drawing in lines (lines with
arrows at their ends) as an additonal way of showing the link exists.

For basic information on making links, read the Section on Links. For information on arranging link
lines see the Section on Link lines - arranging.

Tip: Remember, it is not possible to have a drawn line without also having an underlying DoView link.
Howewer, you can have an underlying DoView link without also having it also represented by a
drawn line.

Tip: When working with drawn lines, you should first make sure that you are in the right viewing
mode. From the View menu select the Show links and drawn lines mode. This mode will show both
underlying DoView links and any drawn lines. For further information see the Section on Views for
Links and Lines.

Drawing link lines

To draw lines for links, select the Insert link, and draw straight line mode from the small black down-
arrow to the right of the Link Tool on the Too Bar to put in straight line links. To put in bent line links
select Insert link, and draw bent line. The thickness of a line can be set by a Right-Click > Line
Width.

N g @

Undo Step  Link Actual Size

Insert Link only

* Insert Link, and draw straight line

Insert Link, and draw bent line

Make many links at once

Make many reverse links at once

The Link tool icon changes between three icons - the one for Insert link only without a drawn line; the
icon for Insert link, and draw straight line; and the icon for Insert link, and draw bent line depending on
which option has been selected from the drop down menu beneath the arrow next to the Link Tool.
The three possible icons are shown below:

~. = EHE.=E 5 E.E

Step  Link Group Step  Link Group Step  Link Group
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Links are made by selecting the step you want to link from, left clicking on the small blue square in
the middle of the selected step and dragging your mouse out and over the step you want to link to.
Alternative you can just select a link and hold down Alt as you do a left-mouse drag out and ower to
any step you want to link to. For more information on making links see the Section on Links.

Inserting different types of links

If a link is made when the Insert link only option is selected from the Link Tool on the toolbar, a
DoView link only is inserted as in the left-hand side of the screenshot below. Howeer, if a link is
made using the Insert link, and draw line mode (either for a straight or a bent line link), a link and a
drawn line is inserted at the same time, as in the right hand side of the screenshot below.

HEFE- 5 O dFE- = 2

Save Step Lirk: Group Save Step Link: Group Te:

e

Automatically inserting links

One of the things that distinguishes DoView from standard drawing software is that in DoView there
can be a link between steps even where there is no drawn line and arrow. This means that the user
can automatically draw as line links, underlying multiple links between steps. So for instance,
DoView links can be made between steps on various pages. These steps can then be cloned onto
another page (say a large poster-sized page) and the pre-existing links between steps can be
automatically drawn in. Link lines automatically inserted by Right-clicking on a step > Draw every link
line. They can be erase in a similar manner (Right-clicking on a step > Erase every link line). The
screenshot on the left below shows the pre-existing DoView links and the screenshot on the right
shows how the link lines have been automatically drawn in after Draw every link line has been
selected from a Right-click on the step.
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¥ B Edit Details...
This appears on »
Rotate k

Copy
Delste

This makes happen
This is the result of
Change color
Format

Picture

- v v v w

Draw every link line

Crill down to new page 2
Set page-jump... k

DoView knows that there is a link between steps even when there is no drawn line link. This means
that if steps

Erasing links

Right clicking on a link line, or a DoView link, shows a menu as in the left-hand section of the
screenshot below. Selecting Erase Line only gets rid of the link line, but does not delete the
underlying DoView link as shown in the middle section of the screenshot. A line can also be quickly
erased by re-dragging from the blue box in the center of a selected step out and across the step to
which it currently has a drawn line. Selecting Delete Line deletes both the underlying DoView link
and its drawn line as shown in the right hand section of the screenshot.
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16 Views for links and lines

Three options are available for viewing links within DoView. These are selected from the View menu

at the top of the screen.

= Help

options
Hide Links ,..cﬁi"i
Showe Links Cnly
Show Links and drawn Lines

Actual Size Cirl+0
Zoorm to Fit

ZFoom In Cirl++
Zoom Cut Cirl+-
Model Direction »

Link viewing

51

For further information on making links see the Section on Links, for information on drawing link lines
see the Section on Links and Drawn Lines.

e Hide links view option does not let you see any link information (either DoView link icons or line

and arrow links).

¢ Show links view option only shows the underlying DoView link icons (these only appear when you
select a step which is linked to another step). You can view the links to and from any step by

clicking on a step.

e Show links and drawn lines view option shows both the underlying DoView link icons when you click
on a step and any drawn lines for those links.

In the screenshot below, all of the yellow boxes are linked to the blue box at the top. The Hide links
view option has been selected from the View menu and no link information at all can be seen

regarding the steps on the page.

(]
o o
=]

In the screenshot below, the Showlinks only view option has been selected from the View menu.

Because the middle step is selected, the DoView link icon in the blue steps shows that the middle
yellow step is linked to it. The same would apply if you selected either of the other yellow steps as
they are also linked to the blue box at the top.
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In the screenshot below, the Show links and drawn lines view option has been selected from the View
menu. The link icon for the middle yellow box is shown as in the screenshot above, however in this
view option, all of the drawn lines for the links are also shown.

IIIIIH-—I>

Tip: Remember that you can not have a drawn line without also having an underlying link, but that
you can have an underlying link without also having it represented by a drawn line. So in the
screenshot below, the drawn line for the link from the right-hand yellow step has been erased (using
a right click on the line > Erase line). Because DoVew is in Show links and drawn lines view option,
you can see the drawn lines for the two yellow steps on the left and in the middle. In addition,
because the right yellow step is highlighted, you can see the link icon for the link between the right-
hand yellow step and the top blue step.

When you insert a drawn line link (see links and drawn lines) DoView automatically turns on the
Show links and drawn lines mode if it is in any other mode.
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Link lines - arranging

Link lines are drawn lines and arrows which show an underlying DoView link exists. These drawn
link lines are arranged on a page by dragging the highlight boxes (green and red) which appear when
a drawn line is selected. To mowve a link line you need to drag one of the highlight boxes, you cannot
drag the link line itself. DoView has some smart line arranging features which make arranging link
lines fast and easy.

Lines and arrows are drawn by selecting the Insert Link, and Draw Straight (or Bent) Line options from
the small back down-arrow on the Tool Bar. For information about how to insert drawn lines to
represent links between steps on a page see the Section on Links and Drawn Lines.

Tip: When working with drawn lines, you should make sure that you are in the right viewing mode.
From the View menu select the Show links and drawn lines mode. For further information see the
Section on Views for Links and Lines.

Note that DoView can work in a Left-to-Right mode or a Bottom-to-top mode depending on the
direction in which you want to draw the model. See the Section on model direction. The examples
below are from Bottom-to-top mode but the same approach applies to Left-to-Right mode.

Dragging green highlight boxes

In the screenshot below, a drawn line representing a link between Step One and Step Two has been
selected (by clicking on the link line). Note the highlight boxes in green, these are used to drag the
line when rearranging it. The red highlight boxes are the connection points of the line to the steps -
these can also be dragged to any position around the border of the steps. Note also that the normal
DoView link icons (an inverted V on the bottom border of Step Two and two small lines sticking up
from the top border of Step One also always appear when you select a link line). The horizontal
segment can be dragged up and down the screen by holding down a left-mouse click and dragging
either of the green boxes up or down.

Step Two

]
I

Step One

Dragging red connection point highlight boxes

In the screenshot below, the red connection point has been dragged out to the left-hand side of the
border around Step One (dragging using a left-mouse click). When this happens, an additional
segment is automatically put into the line so that it now has three green highlight boxes (rather than
just the two shown in the screenshot abowe).

© 2007-2011 The Ideas Web Ltd



Link lines - arranging 55

Step Two

Step One

Adding and removing segments

In the screenshot below, an further segment has been added using a right-click on the link line and
selecting Add segment This new segment is close in towards the left hand side of Step One. Note
that there are now four green highlight boxes. You can add as many extra segments as you like to
make complex link line arrangements.

Step Two

)

1 Edit Details. ..
Delete Link

- Erase line
Step One

Add segment

E Femowe segrment

Straight line

To turn you bent line links into straight line links, simply remowe all segments apart from one (right-
mouse click on the link line and select Remove segment). This has been done in the screenshot below.
An easier way of making a straight line link is to just select Insert link, and drawn straight line from the
link options list accessed from the small down arrow next to the Link Tool on the Tool Bar.
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Step One

'‘Clamping' a segment to the top of a step

The screenshot below shows 'Clamping’. When a link line is first drawn, the horizontal segment
‘clamps’ to the top of the step from which it is drawn. This makes it much faster to move steps
around without having to separately adjust the spacing of the link line segment immediately above
them. In the left-hand section of the screenshot below, the horizontal segment of the link line is
locked in position just above Step One. If you, for instance, drag Step One down the screen, the
‘clamped' horizontal link line segment will move together with Step One down the screen and remain

in the same clamped position just abowve the top of Step One.

Step Two Step Two
/f. Fay
II =
Step One
Iil =
Step One

To 'Unclamp'’ the segment, just drag one of the green highlight boxes up and away a little from Step
One. From then on, if you move Step One up or down the screen, the horizontal segment of the link
line will remain where it is and not move with Step One. The result of this is shown in the screenshot
below. If you reposition the horizontal segment back close to the top of Step One (or if you drag it

close to the bottom of Step Two) it will automatically reclamp.
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Step Two

FaN

Step One

Aligning link lines

The best way of aligning link lines where a number of steps linking to a higher step is to insert the
steps you want (double click on a white space on a page), draw the link lines you want (see
Section on Links and Drawn Lines) and then just use the adjust command (select all the steps you
want to adjust, right click on the one which is at the right level and select Layout > Alight top).

Edit Details. ..

This appears an ¥

Rotate ]
Copy

Delete

Align Top
Align Left

Sarme Size

-

This makes happen

-

This is the resulk of

hange colour v

Drrill davan to nevw slice
Set hop-ta slice. ..

Delete hop-to

This will result in the alignment of the link lines shown in the screenshot below.
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Clones

A clone is a 'live copy' of certain objects which duplicates aspects of the object (its hame,
associated row in the details table, and links if it is a step). Amending these aspects of a clone
amends them for all other clones of the particular object.

Clones are made by copying an object (Right-click > Copy) and pasting it as a clone (on a blank area
of a page Right-click > Paste as Clone). Now the original object and the clone copy are both clones -
so any changes made to the name, record or links of either of them, will automatically be applied to
both of them.

Clones can be made for the following objects: steps, groups, indicators, guestions and items.

Clones are indicated by a shadow down the right-hand side of the clone. In the screenshot below the
clone objects all have shadows down one side.

Tip: Clones let you build 'non-siloed' outcomes models since the same step (outcome) can appear
on more than one page within a model..

Clone of Group 3 Clone of Group 3
Clone of Step 1 Clone of Step 1
[ Indicator & [P Clone of Indicatar 2 [P Clone of Indigatar 2
Step 9
€ Question 7 &P clone of Question 4 D Clone of Question 4
Elitem s [E clone of Item & [E clone of tem &
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Model direction

DoView supports models drawn as Bottom-to-Top models or Left-to-Right models. You can change
the direction of your model using the View menu and selecting View > Model Direction > Left-to-Right
(or Bottom-to-Top).

In Left-to-Right mode, three things happen:

1. The DoView link icon appears on the left and right rather than the bottom and top of a step

2. When you are putting in line and arrow links, the automatic formatting works from Left-to-Right
rather than Bottom-to-Top

3. When you drill-down to another page, the clone of the step you have drilled-down from appears on
the right-hand side of the new page, not the middle top.

N\

[ [
-
m
-

Model direction Bottom-to-Top

il

Model direction Left-to-Right
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Format text

Text in any of the objects on a DoView page can be formatted in various ways. This includes the text
object,and text inside steps, groups, indicators, questions, web or file hyperlink, and items.

Text is formatted by selecting from the Right-click menu. Bold, italic, font size and text alignment
can be selected. Only a limited number of fonts are available in DoView. This is in order to keep the
program very simple to use, for instance, for when using it in front of a group with your model

dataprojected on a screen.

o o

2

a'his ic toviDd
Rotate 2
Copy
Delete
Bold
Italic
Set page jump...
Delete page jump Align Text
Formating text
Brhis ig textd
Rotate 3
Copy
Delete
Bold
] Italic
fp:t_p?gi]ru_mp' Font Size

Small
Medium

Large

Extra-large

Huge
Banner

Aligning text

Align Left
Center
Align Right
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21 Pan

The Pan tool is selected by using the Pan tool on the Tool Bar.

Pan lets you mowve a larger page around when it is viewed within a smaller main page window so that
you can see the area of the page you want to see.

fg*[ ~Pan Tool J @l Q O 4> @

Pan ACtual Size Zoom to At Zoom Im Zoom Out Show Page List | Prev Mext
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Text

Text can be put onto a DoView page using the text object. It can be resized (Right-click > Format >
Font size) to small, medium, large, extra-large, huge and banner sized. .

Banner sized

This Is huge text

This is extra-large text

This is large text
This is medium text

This is small text

Putting text on a page

¢ Clicking on the Text Tool in the Toolbar and clicking on the spot on the page where you want the
text

e By going to a blank area of a page and doing a Right-click > Text

e By pushing Alt 3

e By copying existing text (Right-click > Copy) and pasting it (go to a blank area of a page and do a
Right-click > Paste).

Copying and pasting text

Text from within DoView objects (steps, indicators, questions, items) can be copied using Ctrl C or
Right-click > Copy. Such copied text (or text copied in a similar way from external programs (such as
Word, Powerpoint etc.)) can be pasted a text object by first creating the text object (using one of the
methods listed abowe) and then pushing Ctrl V, or Right-click > Paste.

Including a page-jump with a text object
Text objects can have page-jumps associated with them. These are small triangles which allow you
to jump to another page.

Creating a stand-alone page-jump from a text object
A stand-alone page-jump can be created by inserting a text object, entering a little text into the text

object, creating the page-jump (Right-click > Set page-jump) and then deleting any text from the text
object.

Text objects do NOT have rows associated with them in the details table. Text objects CANNOT be
cloned.
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Groups

Groups consist of a rectangular box drawn around other objects. They simply allow you to visually
group other objects.

Putting a group on a page

e Going to a blank area of a page and doing a Right-click > Group

e Pushing Alt 2

e By copying an existing group (Right-click > Copy) and pasting it (going to a blank area of a page
and doing a Right-cdlick > Paste).

Agroup of steps

Step Step Step Step
1 2 3 4

Groups have rows associated with them in the details table as shown below:

| (] Type | Flag | Marme Description Motes Waorking Notes

This is a group A description of the group  Mokes abouk the group  'Working notes about the group

Cloning a group
A group can also be pasted as a clone - a 'live copy' with a shadow of the indicator icon down one
side as below (Right-click > Copy, go to where you want the clone and do a Right-click > Paste as
Clone. Various aspects of a group's other clones (if it has any) are updated whenever the cloned
group is updated.
Thisis a
cloned
group

By double clicking on a group without a name in it, it can be turned into a continuous box with no
space for a name at the top.

Putting a page-jump on a group

Groups can have page-jumps - small triangles in the bottom right-hand corner of the group which lets

you jump to another page.
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Rule-line

Rule lines are lines which can be added to a page. They can be used to visually mark levels between
elements on a page or for any other purpose. They can be either undashed or dashed. Whether they
are dashed or undashed is determined by selecting dashed or undashed on a Right-click.

Putting a rule line on a page

e Going to a blank area of a page and doing a Right-click > Rule line and dragging the end of the line
out as long as you want it

e Pushing Alt 5 and then dragging the end of the line out as long as you want it

e By copying an existing rule-line (Right-click > Copy) and pasting it (go to a blank area of a page and
do a Right-click > Paste).

Making vertical rule lines
Rule lines can be horizontal or vertical. The default setting for rule lines is horizontal. To rotate a
horizontal line, select the rule line and: Right-click > Rotate > On aside.

Rule lines do NOT hawve rows associated with them in the details table. Rule lines CANNOT be
cloned.Rule lines CANNOT have page-jumps associated with them.
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25 Indicators

Indicators consist of an indicator icon (small yellow icon) and an indicator name. Indicators represent
measures of how steps (outcomes) are changing.

[l This is an indicatar

Putting an indicator on a page

e Going to a blank area of a page and doing a Right-click > Advanced > Indicator

e Pushing Alt 5

e By copying existing indicator (Right-click > Copy, go to where you want the indicator and do a
Right-click > Paste.

Indicators have rows associated with them in the details table.

Cloning an indicator

An indicator can also be pasted as a clone - a 'live copy' with a shadow of the indicator icon down
one side as below. Right-click > Copy go to where you want the clone and do a Right-click > Paste as
Clone. Various aspects of an indicator's other clones (if it has any) are updated whenever an
indicator is updated.

[Li¥ This is a eloned indicatar

Right-clicking on a selected or unselected indicator gives the following menu which allows you to do
things with the indicator

EE-T"iaia ;" ing= =
Edit Details...
This appears on »
Rotate k
Copy
Delete
Faormat r
Show Details b
Drill down to new page »
Set page jump...

But, double clicking on a selected or unselected indicator selects the indicator name, right-clicking
when the indicator name is selected gives the following menu which allows you to cut and paste
etc. the indicator name. The Input Method and Insert Unicode Control Characters options are for use
with different languages.
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£

Copy
Paste
Delete

Select Al

Inpuk Methads ¥

Insert Unicode Conkral Characker ¥

Including a page-jump with an indicator
Indicators can have page-jumps associated with them. These are small triangles which allow you to
jump to another page.

Indicators CANNOT be linked with themselves or with other objects, only steps can be linked and
only to themselves. Indicators can be visually associated with other objects by how close you
position them near to the other objects on a page.
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Questions

Questions are used to put questions on a page which may be related to particular steps (outcomes).
They are used for evaluation questions, research questions or other questions about outcomes or
other objects on a page.

m] a
) This is a question @ This is a small text size questian E:)This is a sglected questiof

Putting a question on a page

¢ Do a Right-click > Advanced > Question on a blank area of a page; or

e Push Alt 6.

e Copy an existing question (Right-click > Copy, go to where you want the question and do a Right-
dick > Paste).

Questions do have rows associated with them in the details table.

hin] | Type | Flag | Marne | Drescription | Motes | ‘\Working Motes

16 @ O Thisisa guestion A description of the question  Motes about the question  Less formal working notes about the question

Cloning a question

A question can also be pasted as a clone - a 'live copy' with a shadow of the question icon down one
side as below. Right-click > Copy go to where you want the clone and do a Right-click > Paste as Clone.
Various aspects of a question's other clones (if it has any) are updated whenewer a cloned question
is updated.

) @This is a cloned question

Including a page-jump with a question
Questions can have page-jumps associated with them. These are small triangles which allow you to
jump to another page.

Questions CANNOT be linked with themselves or with other objects, only steps can be linked and
only to themselves. Questions can be visually associated with other objects by how close you
position them near to the other objects on a page.
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ltems

Items (the item icon with attached text) are one of the several types of objects which can be put onto
a DoView page. Items can be used for any type of item you may want to put onto a model, e.g.
person, project, thing etc.

[m] [m]
[ Thisis anitemn [ This is a small test item g:IThis is a splected item O

Putting items on a page

e Going to a blank area of a page and doing a Right-click > Advanced > Item

e Pushing Alt 6

e By copying existing item (Right-click > Copy, go to where you want the item and do a Right-click >
Paste.

Questions do have rows associated with them in the details table.

‘ jin] | Type | Flag | Marne | Description | Mokes | Waorking Motes

| 20 [l O Tthisisanitem & description of the item Motes about the item  Less Formal working notes about the item

Cloning an item

An item can also be pasted as a clone - a 'live copy' with a shadow of the item icon down one side
as below. Right-click > Copy go to where you want the clone and do a Right-click > Paste as Clone.
Various aspects of an item's other clones (if it has any) are updated whenever an item is updated.

0 This is a cloned item

Including a page-jump with an item
Items can have page-jumps associated with them. These are small triangles which allow you to jump
to another page.

ltems CANNOT be linked with themselves or with other objects, only steps can be linked and only to
themselves. ltems can be visually associated with other objects by how close you position them
near to the other objects on a page.
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Pictures

Pictures include photographs, graphs, images and any other type of graphics. DoView can insert
pictures in any of the following formats: jpg, png, bmp, or gif.

Add a picture to a page:

e To insert the picture from an existing file. Right click on a page's background and select Right-click
> Picture (keyboard shortcut Alt 4)

e To paste it from another application. Copy the image (in e.g. Word, Powerpoint, Internet Explorer,
or Firefox) and paste it into DoView. Right-click on a page's background and select Right-click >
Paste, (keyboard shortcut CTRL V).

Note: DoView supports transparent pictures (alpha channels). Howewer, these are best loaded from a
file rather than pasted from the windows clipboard as many applications strip the transparent part
when copying the picture. A symptom of this is the appearance of ugly black blocks appearing in the
pasted picture. A work-around is to awid copy and pasting by saving the picture as a file in a format
supporting transparency (e.g. png) and then loading that file into DoView.

Rotating a picture
To rotate a picture, select the picture by clicking on it and then: Right-click > Rotate > On aside

Shrinking or enlarging a picture
To shrink or enlarge a picture, click on it and then hold down a Left-Click on one of the small green
squares in the four corners of the picture and drag it larger or smaller.

Note: As with any picture pasted into software, if a picture is resized from its original size there may
be some distortion (e.g. if a very small picture is dragged out to be large it may become pixelated).

Add a picture to a step:
e Select the step and Right-dick > Image > Choose Picture.

You can choose how the picture will appear. The three options are:

e Standard shape - this gives steps which include a picture a uniform appearance because all of the
pictures within them have the same size (these have a width:height ratio of 3:2).

e Cropped border - as for standard shape, but with a border cropped from the original picture.

¢ Original shape - this keeps the original shape of the picture.

In addition to the thumbnail size picture included within a step, DoView also includes the original
sized picture so that it can be seen on a Right-Click > Show Picture. This can be useful in
presentations (Right-click > Show Picture) when you want to talk to an audience about the step and
use the large version of the picture to make a point. The larger version of the picture is also included
in any web page model you make (show it by a Left-Click on the picture in the web age model).
There is an option to not include the original-sized picture to minimize the file size when saving a
picture. This option can be checked at the time that the picture is inserted into a step (Reduce file
size; do not include the original sized picture). If this option is selected it will mean that Show Picture
and Left-Clicking on a picture in a web page model will NOT show the original sized version of the
picture. For more information on positioning pictures within steps see the Section on steps.
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29 Arrow

A resizable arrow can be inserted on any DoView page.

Paste

Step X1

Croup 2
Text 3
Picture 4
Rule Line X5

Link to Web or File e
Direction Painter

SN —

Advanced >

Putting an arrow on a page

¢ Going to a blank area of a page and doing a Right-click > Arrow

e By copying an existing arrow (Right-click > Copy) and pasting it (go to a blank area of a page and
do a Right-click > Paste).

Changing the arrow orientation
The arrow's orientation can be changed by doing a Right-click > Orientation.

Arrows do not NOT have rows associated with them in the details table. Arrows CANNOT be cloned.
Arrows CANNOT have page-jumps associated with them.
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30 Locking

Any object on a DoView page can be 'locked' in position. This means that it cannot be mowed.
Howewer any other aspect of it can be edited when locked. A locked object has blue 'handles' rather
than the normal green 'handles'.

Locking is useful for making templates which are then distributed to others.

—_— e Edit Details...
This appears on *

Rotate >
Copy

Delete

This makes happen
This is the result of
Change color
Dashing

Format
Watermarks

e

Picture

O —

Drill down to new page *
Set page-jump...

Locking
e When an object is selected Right-click > Lock
¢ To unlock select an object and Right-click > Lock
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31  Traffic lights for status

Step boxes can hawe 'traffic lights' inserted into their top right-hand corner to show the status of a
step box. When clicking on a box, traffic lights can be inserted by clicking on the traffic light you
want in the window which opens up at the bottom of the Page List. The traffic light is removed by
clicking on the grayed out status traffic light.

@ v & K

3| Mew 1x1 Page Mew Folder Delete Page

- ﬁ Status: |

Traffic lights can only be set for step boxes.
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32 Shapes as watermarks

Shapes can be placed within steps boxes in DoView as watermarks. Shapes such as triangles are
very uneconomical in terms of the amount of text which can be put into them, in order to economize
on space (and allow you to fit as much as possible onto a page), DoView lets you put shapes into
your model as watermarks on standard DoView boxes.

Shapes are inserted with a Right Click > Watermark.
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33 Colors

Boxes and text can be colored in DoView. Do a Right-Click > Change Color. A Projector Optimized
color palette is available. These are colors which are most likely to be able to be differentiated when
used with a Dataprojector. A Designer palette is also available. In addition, if a user wants to set any
color they can select from the Custom Color picker located under the Change Color > Other Palettes

option.
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34

Details table

The details table runs along the bottom of the DoView screen. The top edge of the details table can
be dragged up to make the details table larger or dragged down to make it smaller.

Z5 DoView
Ble Edit View Hep

& B He HEE.E6A 2 g @ @ @

Back Open Save Undo Step Link Group Text Pan Actual Size Zoom to Fit ZoomIn Zoom Out

[*[ Page List

Step 3 Page One 1
Page Twp 2
Page Three 3
Page Five 5
Page Siz [
Page Seven 7
Page Eight 8
Page Nine 9

Step 1 | Step 2

Details table & o =
(T | [¥) | New ixiPage New Folder
D Type | Flag| Mame Description ; ’/ Notes Working Notes

Group 1

D]

Indicator 1 This is some information
Question 1 Here are some notes,

Item 1

Step 1

1 I

mme e B

Rows within the details table are associated with some of the objects (e.g. steps, links, indicators,
questions, items) that can be put onto a page. The rows allow additional information to be added
about an object.

When you select an object that has an associated row in the details table, the row is highlighted.
The row can be edited by: 1) double clicking on the row; or 2) doing a Right-click > Edit details on an
object which has a row associated with it in the details table. In the case of links you can just
double click on the link itself to access its details.

In the example below the rows associated with a number of objects can be seen. Notes have been
added for the Indicator. A description has been added for the Group and notes have been added fpr
the Item. The row for Question 1 has been flagged (an orange box has appeared at the left-hand end
of the row). Note that a different icon for each type of object appears in the type field of the details
table.
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jinj | Tvpe | Flag ‘ Marne Cescripkion Miokes

Outcome 1

Indicatar 1 Some nokes about Indicator 1
Group 1 & description of Group 1

Question 1

Item 1 Some nokes about Tkem 1

Qutcame 2

O00®O00O0

Qutcame 1 = Oukcome 2

Rows contain fields where you can put additional information about an object. These fields are: the
object ID; its type; flag; name; description; notes; and working notes. When you are editing details
about an object you enter information into any of the fields into a dialogue box like the one below.
You access this dialogue box by a Right-click > Edit details.

i

=
Step 1 r s
Editing Step ‘Step 1' | 22

I Mame l Description Motes Working Motes
Here we are adding information about this step,

Cancel l (] 4 |
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Fields

Rows in the details table (which are associated with some DoView objects, steps, links, indicators,
questions and items) hawe four fields - name, description, notes and working notes.

i} | Type ‘ Flag ‘ Mame Descripkion Motes Working Motes
g €3 ® Question 1 Descripkion

g B O temt Mates

i O oubcome 2 wiorking nokes

Entering information into the fields of rows in the details table

1. Selecting the object for which you want to add additional information. This will highlight the row in
the details table associated with the object.

2. Double clicking on the highlighted row in the details table. An editing box will open which will have

four tabs, one for each of the fields in the row - name, description, notes, working notes.

A
i Editing Step 'Step 1°
Mame | Descripkion Motes Warking Mokes |
Step 1
Cancel oK

3. Clicking on the tab of the field you want to enter information into.

4. Typing the information in.

5. Clicking Apply if you want to save the information in the middle of typing it in (for instance if it is a
lengthy piece of text).

6. Clicking OK when you have finished entering the information.

An alternative way of accessing the associated row in the details table is to do a Right-click > Edit
Details on an object (step, link, indicator, question, item) with has a row associated with it in the
details table.

Fields can be displayed on a page one at a time. See the Display Fields Section.

Tip: You can use the 'notes' field for formal notes about an object which you have completed and
which you may wish to display on a page with the display fields option. You can then use the
‘working notes' field for more informal notes to you and your colleagues about your thoughts, or
things you need to find out about the object etc.
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Layout

Steps, or other objects, can be aligned using the Layout command.

Alight top or left

Select all the steps you want to align, right-click on one of them and select the type of alignment
you want - align top or align left.

Resize steps

In addition, Layout can also be used to resize steps. Select the steps you want to make the same
size, move to the step you want the other steps to be the same size as, do a Right-click > Layout >
Same Size.

This makes happen
Thiz is the result of 3
Change color 3
Format »
Picture 3

Drill down to new page 3
Set page jump...

Tore-size steps select all the steps you want to resize, right-click on the one you want to resize them to
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37 Folders

Folders are headings which can be put into the page list. Pages can be nested under folders.
Folders are not pages so clicking on a folder will not change the page in the page viewing area,you
will continue to see the same page as is currently in the page viewing area.
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38 Rows

A row is a line in the details table at the bottom of the DoView screen which is associated with
selected objects - steps, groups, indicators, questions and jtems.

A set of rows in the details table is shown below. See the Details table Section for more detail.
Rows can be flagged (an orange block of color to the left of the row).

jinj | Type | Flag | MName Description | Motes

Cugkame 1

Indicator 1 Some notes about Indicator 1
aroup 1 A description of Group 1

Cuuestion 1

Iterm 1 Some nokes about Them 1

Qutcome 2

OO0 @®000

Cubcome 1 = Cukbcome 2
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39 Zoom

Zoom is accessed from four zoom tools on the toolbar.

Zoom tools
H & . A 2 8§ @ @ Q

Save Undao Step  Link Group Text Pan Actual Size  Zoom to Fit Zoom In  Zoom Qut

Actual Size

Shows a page at its actual size. All of a compact 1 x1 page can be seen in the main page window if
the page list is not shown and the top of the details-table is dragged down the screen sufficiently (in
1024 x 768 screen resolution, see the Section on screen resolution). Often, only part of pages larger
than compact 1 x1 pages can be seen in the main page window as it will be larger than the page
window. You can mowve around a large page when zoomed to actual size by using the sliders at the
right-hand edge and the bottom of the main page window, or by using the Pan tool on the tool bar.

Zoom to Fit

Zoom to Fit will fit all of a page into whatever space is available in the main page window. Larger
pages will be zoomed out more than compact pages. In Zoom to Fit mode you can still make links
in the normal way and mowe objects around on a page.

Zoom In
Zooms into a page so it shows the steps and other elements on the page as being larger.

Zoom Out
Zooms out of a page so it shows the steps and other elements on a page as being smaller.
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40

Screen resolution

DoView has been optimized to allow you to dataproject your model when it is broken up into
compact 1 x 1 pages. This is a key part of DoView being designed to make building models with
groups easy. Many dataprojectors use a 1024 x 768 screen resolution which is somewhat smaller
than the setting of most desktop and notebook computers. The compact 1 x 1 page in DoView has
been designed to be able to be viewable when dataprojected on a 1024 x 768 resolution on a normal-
sized screen in a medium-sized room. While you can use the Zoom feature to make your pages
look larger on screen, if it is possible it is useful to set the resolution of your dataprojector to 1024 x
768 so that unzoomed DoView pages are at their most viewable.

The resolution of your dataproject is set from your computer. You can tell which resolution your
dataprojector is set on by looking at a compact 1 x 1 DoView page when dataprojected onto a
screen. If some of the compact 1 x 1 page is obscured when the Page list is showing, then you are
on the correct resolution (1024 x 768). If you can see all of the page when the Page list is showing,
then you are probably on a too high a resolution. While higher resolutions may be fine on your
desktop or notebook computer, when your DoView model is dataprojected, it will mean that the
steps and other elements on the DoView page are likely to be smaller than they would be if you
used a 1024 x 768 screen resolution on your dataprojector.

To change the screen resolution in Windows XP you go into Control Panel > Display. In Windows
Vista you go to Control Panel > Appearance and Personalization > Adjust screen Resolution.

Just set the screen resolution to 1024 x 768 and the steps and other elements on the DoView page
should get a little larger so that people in the audience can see them more easily. In 1024 x 768
screen resolution close the page list so that you can see all of the page.
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41  Direction pointer

A direction pointer can be inserted to show the model direction. The model direction is the direction
in which the model 'flows". In a Bottom-to-Top model, the highest-level step (or outcome) will be the
highest step at the top of the page. In a Left-to-Right model, the final outcome will be on the extreme
right of the page.

Left-to-Right direction pointer

The direction in which the direction point points is determined by the model direction when the
direction pointer is inserted. The direction of the direction pointer can be changed from Left-to-Right
to Bottom-to-Top by doing a Right-mouse click > Rotate > On a side.
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42  Flag

A flag is located on a row within the details table at the bottom of the DoView screen. Clicking on
the flag circle simply flags the row for your future reference. You may do this to remind yourself that
you have not yet finished putting information into the row or for any other purpose.

In the screenshot below the row associated with Step B has been flagged by clicking on the small
circle in the Flag column. The fact that this row is flagged is shown by the block of orange color over
the row ID at the left end of the row.

] | Tvpe | Flag | Mame Description Mokes WWorking Motes

1 o Skep A Descripkion of Sktep A Maokes on Skep & Warking notes on Step A
z ® StepB

3 O stepcC
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43 Rotate

Some objects (steps, groups, text, indicators, guestions, items, rule lines) can be rotated.

Rotating an object
® Right-click > Rotate > On aside.

To return an object to normal:

® Right-click > Rotate > Level.

The screenshot below shows text, steps and indicators which have been rotated.

=
@
&
=]
@
=
[}
=
=}
o

Level text

Level step
=]

Rotated step

Use as slice name

Copy
Delete

Edit Details. ..

This appears on

[l Level indicatar

This makes happen
This is the result of

[l Rotated indicator

Change colour
Drill dowen to new slice

Set hop-to slice...

Delete hop-to

L3

on a side
Lewvel
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44  Show details/fields

The fields of selected abjects (indicators, questions and items) which have rows associated with
them in the details table can be displayed directly on a page. This is possible for indicators,
questions and items. But not for steps or links.

Showing details/fields for some objects
¢ Right-click > Show Details and then selecting the details you want to show.

Note: The description, notes and working notes fields can only be displayed one at a time.

The screenshot below what happens when you Right-dick > Show Details on the item called ‘This is

an item'.
B3 This ig an jtemB

Edit Details. .

This appears on 3

Rotate 3

Copy

Delete

Farmat 3

ow Deta Icon Only
—*® Show Content

Description
Motes

Warking Motes

The screenshot below shows part of a page illustrating the results of displaying different fields for
clones of the item "This is an item’.

El This is an item

Motes: The notes associated with this item are
heing displayed here on this slice beneath the
itermn and under the heading Motes.

El This is an item

Working Notes: This is the information put into
the Waorking Motes fiel of this item.

El This is an itemn

Description: This is the information put in the
Description field of this item.
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45

Copying pages

Up to Version 1.02 of DoView there was a Copy Page button in the toolbar, from Version 1.03
onwards this has been replaced by the ability to copy pages using a right mouse click in the page
list. This is used to: 1) copy pages within DoView; 2) copy and paste a page into an outside piece of
software (Microsoft® Word, Powerpoint, Outlook® etc.) using Windows Clipboard for a single page,
or Office Clipboard for multiple pages; or 3) copy and paste pages between instances of DoView

(see the Section: Pages, copying between models.

Copying pages within an instance of DoView

A single page which has no pages under it. Select the page name you want to copy from the
page list and Right-click > Copy. Go to the page or folder under which you want the page to be copied
and Right-click > Paste.

Tip: if the entries in the page list do not take up all of the space in the page list you can Right-click >
Paste on the white space at the bottom. In this case the page will be pasted under the currently
selected page name.

Pages or folders with one or more pages under them. Use the same method as for a single
page and all of the pages and folders beneath a page or folder will be copied and pasted.

Copying a page with other pages under it

If you just want to copy a page on its own which has other pages under it, you can either: 1) leave
the pages list, go onto the page itself, select and copy all of its context with a Ctrl A Ctrl C, then
create a new page (by using the New Page tool in the page list) and then paste the contents onto that
new page (Right-click > Paste); or, 2) copy and paste the page and the pages below it using the
method set out for copying a single page above and then just delete the additional pages which were
under the page you want copied.

Pasting a single page to external software using Windows Clipboard

Select the page name you want to copy from the page list and Right-click > Copy as Image. Go to the
other software (Word or Powerpoint) and do a Right-click > Paste, Edit > Paste or Ctrl V to paste an
image of the page into the other software.

Using Office Clipboard for pasting multiple pages into external software
You can quickly get multiple pages out of DoView to put in other software using a feature available in
some versions of Microsoft® software.

1. Go to Word, Powerpoint or Outlook and select Edit > Office Clipboard from the main menu. This

will open a window down the right-hand side of the application called 'Clipboard'.

. Click Clear All to get rid of anything currently in the clipboard.

3. Return to DoView (the Alt Tab shortcut will get you there fast) and mowve through all of the pages
you want to put into Word or Powerpoint. Click on the page name in the page list to get each
page to open in the main page window and Right-Click > Copy.

4. Return to Word or Powerpoint(again you can use the Alt-Tab shortcut to get there fast). You
should now see all the pages you want in the clipboard window on the right hand side of the
software.

5. Click where you want the pages inserted in Word or Powerpoint and then click on the image of
the page you want to insert in the Clipboard. You can rapidly place a number of pages into Word
or Powerpoint in this way.

N
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Tip: If you copy the pages in DoView in the reverse order to how you want them inserted into Word
or Powerpoint, you will find that they will end up in Office Clipboard in the right order for you to paste

them into the other software in the correct sequence.
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Pages, copying between models

To copy pages(s) between models:

1. Open the file you want to copy from (File > Open).

2. Open the file you want to paste to (File > Open).

You should now have two instances of DoView running (you can move between the instances by
clicking on each instance in turn in the Windows taskbar).

3. In the page list, right-click on the page you want to copy and select Copy. (Make sure you are just
getting the right-click menu shown below, not the right-click menu for editing the page name).

4. Go to the instance of DoView which contains the file you want to paste the page to.

5. In the page list, right-click either on a page name (if you want to paste the page under it) or on the
white area in the page list.

6. Click Paste.

Copying a page with other pages under it

If you just want to copy a page on its own which has other pages under it, you can either: 1) leave
the pages list, go onto the page itself, select and copy all of its context with a Ctrl A Ctrl C, then
create a new page (by using the New Page tool in the page list) and then paste the contents onto that
new page (Right-click > Paste); or, 2) copy and paste the page and the pages below it using the
method set out for copying a single page above and then just delete the additional pages which were
under the page you want copied.
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Page sizes

The default page size in DoView is called the standard compact 1 x1 page. This page has been
designed to be readable on a dataprojector screen in a medium sized room, be printed on U.S. letter
or A4 sized paper and be readable in a web page version of a DoView model.

Howewer, many other pages sizes can be used in DoView in addition to the compact 1x1 page. One
good way of working with DoView is to construct your model out of compact 1 x 1 pages and then
clone (make 'live copies') of your steps and other objects and then paste them onto larger pages (e.
g. poster sizes). To quickly copy the entire contents of a small 1 x 1 page push Ctrl Athen Ctrl C.
Then go to the new larger page on which you want to clone your 1 x 1 model and do a Right mouse-
click > Paste asdone. This means that you can always dataproject your compact model consisting of
1 x 1 pages and create a usable web page model out of it, but you can also create poster-sized
versions of your model. This is why many page sizes in DoView are named as multiples of 1 x 1
pages (e.g. 2 X 2, 6 x 7). This is so that you can know how many 1 x 1 pages will fit onto the larger-
sizes pages. These sizes can be thought of as the number of '‘columns' of 1 x 1 pages on a larger
page by the number of rows' of 1 x 1 pages. E.g. a 2 x 2 page contains two ‘columns' of 1 x 1 pages
and two rows' of 1 x 1 pages - making a total of four 1 x 1 pages which can fit on the 2 x 2 two page.
Similarly, on a 4 x 10 page, there can be four '‘column's of DoView 1 x 1 pages and ten rows' of 1 x 1
pages - making a total of forty 1 x 1 pages which can fit on the 4 x 10 page.

There are also other page sizes (e.g. A4, US Letter) which are not made up of multiples of 1 x 1
pages. The dimensions of pages (in inches or centimeters) are shown when you click on a page
name when selecting it from the New page options screen.

Selecting and creating new page sizes

1. Go to the Small Page List Menu at the bottom of the Page list.

2. Click on the small arrow next to the Create Page icon. Note that you will see listed the page sizes
of any pages which are already in your model, in addition to the option Other sizes...

The screenshot below shows that this model contains two types of page size -1 x 1 and 2 x 2.

o
-
g
B Mew 2%2 Page Mew Folder Delete Page
1x1
Working Motes
* x2
Other sizes...

3. If you want to create a new page (say a 4 x 5 page - which prints to landscape Al 23.39 x 33.07
inches) - click on Other sizes... . You will see the screen below.

4. Select 4 x 5 Prints to landscape Al paper (23.39 inches x 33.07 inches). Click Make 4 x 5 page at
the bottom of the screen. A new page will appear in the Page list, ready for you to name.
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Page sizes
[

-ii.‘ E .—T—  New page options @

o Step  Link ]
Projection Optimised (recommended)

Page List
Easy to present to groups as the whole page is visible on common data- —
projectors. Page
O 1x1
I 2w 2

Larger Pages

]

Descripd]

Built from 1x1 pages. For example, a '2x2' page is the size of four 1x1 pages.

Print Optimised
These make best use of the paper when printed, as they are tailored to its

shape.
) a4
{ ] AS
[ US Legal
| Tabloid

) US Letter

Make 4x5 page ] l Cancel

New 2x2 Pa

5. Whatever page size you selected, will become the default page size which will be created
whenewer you create a page from now on (by clicking on the New page icon) until you select a
different page size. See the screenshot below.

D]

ol K

Mew Folder Delete Page

v

Mew 4x5 Page
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48  Printing as PDF file

All pages in a model, or just a selection of them, can be printed to a PDF file along with the
accompanying information in the details-table. You can send the PDF version of the model to others

by email or use it to print out the model pages and accompanying details-table information. This is
the way you print from DoView.

Print as PDF
To print as a PDF select File > Print as PDF from the main menu at the top of the screen.

Edit  Help |

Mew Model
Mew Slice Chrl+m
CpEM... Chrl+0
Save Chrl45
Save As..,

Prinkt as PDF...

it

Print as PDF options within Doview
Select the DoView printing as PDF options you want from the following screen.
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DoView Help
Print as PDF >4
Slice Lisk

I Second slice 20
Third slice: 30

B Fourthslice 4+

B Firth slice =0

B sicthslice & O

B =eventhslice 70

Haold down <ckrl = to select additional slices.
Hold down <shift = ko select a range of slices,

Include data kable
Include slice names
Mumber pages

Select all Prink PDF Cancel

All the pages which you have selected to print as a PDF file will appear in the PDF file, one to a
page in landscape layout. To select more than one page hold down Ctrl and to select a range of
pages hold down Shift. The PDF printing options are:

Include page names - the name of the page will be printed in the bottom left hand corner on each page
which contains a page.

Number pages - a page humber will appear in the bottom right hand side of each PDF page.

Include data table (details-table) - information from the details-table will be included at the end of the
PDF file. This will be set out in the following format: each step (only steps from the pages which are
being printed are included); any details-table information for that step; information on links to and
from the step (under the headings This makes happen and This is the result of). If there is any
details-table information associated with a link this is shown by there being a small superscript
number next to the initial symbol in the entry for that link (e.g. in the example below of Music played
at appropriate time). This reference number refers to the number for the link. Those links which have
information associated with them are listed at the end of the PDF file.

If there are additional objects on the pages which are being printed to PDF these will be listed in the
order: indicators, questions and items.
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Party venue secure 1

This makes happen:

» Appropriate company 17

This is the result af

« Sufficiently skalled security guards 22
« Sufficient mumber of security guards 1

Satisfactorv entertainment experience o
Description: This includes both the volume and the quality of the music played.
Notes: Dnfferent guests may have different tastes in regard to music.

Working Notes: We need to do some more thunking about what we have called tlus step.

This makes happen:

» Guests feel relaxed s

This is the resuit af:

" Wusic played at appropriate time 24
« Appropriate music s
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49  Modelffile

A DoView model is simply a DoView file. There are three DoView file types - the main file type ends
with the file extension .doview. See Eile Formats & XML Section for more information.

Opening a DoView file

e Use the Open tool on the toolbar

e Select File > Open from the main menu at the top of the screen
® Ctrl-O.

Saving a DoView file

¢ Use the Save tool on the toolbar; or

e Select File > Save from the main menu at the top of the screen; or
* Ctrl S.

A single DoView file can contain all of the pages (diagrams) and related information about one or
more projects. If you want to, you can further document your model by including links out to web
pages or local files.
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50 Multiple instances of DoView

Every time you open a file within DoView a new instance of DoView starts. This lets you work on
more than one model at a time. It also lets you copy and paste pages between instances of DoView

(see the Section on Pages, copying between models).

Opening a new instance of DoView
e Click on the Open tool on the toolbar
e Select File > Open or File > New Model from the main File menu at the top of the screen.
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51 Web page models (creating)

Any DoView file can quickly be made into a web page model for putting up on an intranet or the
internet. Such web page models contain all of the pages from the model from which they were
created, their clickable page-jumps, and a list of pages for navigation (called the Contents list in the
web page model). Web page models do not contain information from the details-table, nor do they
let those browsing them on an intranet or the internet click on each step to see which steps it is
linked to (by revealing the DoView link icons). However, if you select a particular step within a
DoView file (making its DoView link icons appear in any step it is linked to) and then immediately
create a web page model, the web page model will show all of the DoView link icons for the selected
step. If there are any thumbnail pictures included in steps (See Section on Steps) when you click on
the thumbnail in the web page version, a large copy of the picture will appear if it is in the DoView
file.

When you create the web page version of a DoView model, you have the option of including the
following: a Title for the web page model; a logo of your own choosing; a hyperlink beneath the logo;
a copy of the original DoView file you are creating the web page model from; and a PDF of the
original DoView file you are creating the web page model from.

Tip: The web page model you create will include all of the pages (pages) within the DoView file you
are creating it from. Therefore if you do not want some of the pages to appear in your web page
model, save a special copy of your DoView file just for creating the web page model and delete from
it all of the pages you do NOT want to appear in your web page model before you create the web
page model.

To see what a web page version of you model will look like see the Section on: Web page models
(using).

Create web page model
To create a web page model select File > Create Web Page Model from the main menu at the top of the
screen.
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7 DoView

Edit  View Help

Mew Model
Mew 1x1 Page
Open...

Sawve

Save As...

Setlogo...

Print as PDF...

Close

Ctrl+0
Ctrl+5

Create Web Page Model...

The following dialog box will open and you can then put in the Title of the web page model which will
appear along the top of the web page version of your model.

4

Create web page model

Title I.D. web Page Model of Our Pragrar|

These web pages will include all the slices in this model,

(1 nelude the model logo?
(] 1nclude a copy of this model's Doview File?

[] Include a POF File of this model?
P PDF Options

Choose Logao |

Save as..,

Cancel

Including a logo in the web page model
You can include any logo of your choice in a web page model (just locate the file with the logo in it
from your computer). It will appear in the top right-hand corner of the web page version of the model
you create. First you need to choose the logo you want by clicking on Choose Logo. This opens the
dialog box below:
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python.exe

No Logo

Remove Logo Browse For Logo Cancel

Clicking on Browse for Logo opens the dialog box shown below from which you can select the file
containing the logo image you want to include in the web page version of your model.

rLoad Logo Image -

Look if |_J Logos for uze in DoView ﬂ L] l‘j‘ EE-

2 |—E| mohlogo. gif

My Recent
Documerts

Desktop

-

My Documents

oL

y Compter
My Metwork  File name: |untitled ﬂ Open |
Places
Files of type: |AII Supported Image Types j Cancel

The selected logo file will be loaded into the DoView file and remain in the file from then on (you can
load a new logo at any stage). The dialog box below will open and you have the option of putting in a
web address for the logo. This web address is where someone browsing the web page model will go

if they click on the logo which will appear in the top right-hand corner of the web page \ersion of the
model.

python.exe

Web Address; |htt|:|:,l'll'www.schaal.cam|

Remove Logo | Browse For Logo

[8]4 Cancel

When you click OK you will be returned to the dialog box shown below:

© 2007-2011 The Ideas Web Ltd



136

DoView Help

Create web page model

Title: |.ﬁ. Web Page Maodel of Cur Program

These web pages will include all the slices in this model,
iInclude the model logo?; Choose Logo
[ 1nclude a copy of this model's Doview Fils?

[ tnclude a POF file of this model?
F PDF Options

Save as.., Cancel

Including a copy of the original DoView file

If you want to, at this stage you can check the box next to Include a copy of this model's DoView file?
This means that in the final web page version of the model, the option shown below will appear on
the Options bar at the bottom of the web page version of the model. Someone browsing the web
page version of the model will be able to click on this and immediately download a copy of the
original DoView file from which you are about to create the web page version of the model.

Caution: Before checking this option, you need to make sure that you are happy for anyone
to be able to download, use and edit a copy of the original file from which you are creating
the web page version of the model. Also you need to realize that this will give anyone
access to whatever you have written in the details-table in the original DoView file. While
the contents of the details-table do not appear in the actual web page version of the model,
if you give those browsing the web page version of the model the option of downloading a
copy of the original DoView file they will be able to see the contents of the details-table
when they open up the DoView file.

+ m Download the DoView
| ¥ file of this model

Including a PDF of the original DoView file

If you want, at this stage you can check the box next to Incude a PDF file of this model ? This means
that in the final web page version of the model, the option shown below will appear on the Options
bar at the bottom of the web page version of the model. Someone browsing the web page version of
the model will be able to click on this and download a PDF of the DoView model. This PDF will
include the pages in the web page model. The option to include the PDF in the web page version of
the model is so that someone browsing the web page version can download the PDF if they want to
print out all of the pages in the model.

s i Download a PDF file of

A~ this model now

The options available for the PDF are the same as when using the Print as PDF command. When
the option to include the PDF file of the model is checked, the normal PDE options will appear at the
bottom of the dialog box as shown below:
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Create web page model

Title: |.ﬁ. ‘“Web Page Model of Cur Program

These web pages will include all the slices in this model.

Include the model logo? Choose Logo

Include a copy of this model's Doview File?
Include a PDF File of this model?:
= PDF Options

[] 1nclude record table

[ tnclude slice names
Mumber pages

Save as.., Cancel

Creating and saving a web page model

Once you hawve finished checking the options you want as outlined abowve, you click Save as... A
normal file dialog box will open up for you to select the sub-directory on your local computer where
you want to sawve all of the files which will make up the web page model (these are the full set of
HTML and other files needed for the web page model).

Tip: The file name for the web page model should be as short as possible, all in lowercase and
without any spaces. This is so that it will be easy for people to type it into a browser when they want
to go to it on an intranet or the internet.

Save this as

Save in: |_}Web page model sub-directary j " Ic_“F Ed-
Y

G

My Recent
Documents

Desktop

LY

Iy Docurnerts

ey

tp Computer
"1 File name: |webpagemodel j Save |
My Mebwork,  Save as tipe: |W’eb Page j Cancel

Places

The full set of HTML and other files will appear in the subdirectory you have selected. They consist of
a single HTML file with the name you hawve given it (e.g. webpagemodel in this case) and two
subdirectories. The first sub-directory (e.g. webpagemodel-attachments) contains the original
DoView file and a PDF file of the web page model if these options were selected when the model
was created as outlined above. The second sub-directory (e.g. webpagemodel-pages) contains all of
the pages which are included in the web page model. An example of the file and two sub-directories

© 2007-2011 The Ideas Web Ltd



138

DoView Help

which are created are shown below:

__Jaweb page model or our program [Z]@
: Iy
n

File Edit Yiew Favorites Tools  Help

>

GEack > ir / ! Search Folders

- address |03 CiDocuments and SettingsiUseriDeskiopt w ﬂ Go

|_)webpagemodel-attachments
) webpagemodel-slices
,ﬂ webpagemodel, hkml

Publishing a web page model to an intranet or the internet

All that is now needed to publish the web page model onto an intranet or the internet is to transfer
the abowe file and two sub-directories which have just been created to the appropriate sub-directories
on the relevant intranet or the internet. You can ask the the Webmaster of the intranet or internet
site where you want to put the web page model to do this for you. Usually the Webmaster will want
you to zip the sub-directory where you have just saved the files which make up the web page model
and email it to the Webmaster so they can unzip it and place it onto the relevant sub-directory on
the intranet or at an internet site. Alternatively, if you have access to an intranet or internet sit via
FTP, you can just directly copy the file and two sub-directories you have just created which contain
the web page model onto the appropriate sub-directory on the intranet or the internet. Using FTP like
this can be done directly from within File Explorer on Windows or by using any FTP software (like
Cute FTP). You should just ask your Webmaster to set you up in this way to do this very simple
operation to publish your web page model. Publishing your web page model in this way should be no
more complicated that copying files between subdirectories on your own local computer.

For more information on what the final web page version of the model will look like and how to use it,
see Web page models (using).
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Web page models (using)

A web page model of a DoView file is created with the command File > Create Web Page Model. More
information here.

A web page model contains all of the pages from the model from which it was created, their
clickable page-jumps, and the list of pages for navigation. Web page models do not contain
information from the details-table, nor do they let those browsing a model on an intranet or the
internet to click on each step to see which steps they are linked to (by showing the DoView link
icons) as can be done within DoView itself.

Howe\er, if you select a particular step within a DoView file (making its DoView link icons appear)
and then immediately create a web page model, the web page model will have visible all of the
DoView link icons in the steps which are linked to the selected step. For more information on
DoView links see the Section on Links.

When the web page version of a model is created, the user has the option of including the following:
a title for the web page model; a logo of their own choosing; a copy of the original DoView file they
are creating the web page model from; and a PDF of the original DoView file they are creating the
web page model from. If included, a unique feature of DoView is that the original DoView file and the
PDF can be downloaded from the web page version of the model.

Overall look of a web page model

A web page model looks like the one below. Once it is put up on an intranet or the internet, it can be
viewed in any internet browser. If the right-hand side of the web page model is hidden by the
Contents list - it can be turned off by clicking Hide Contents. If the bottom of the web page model is
hidden by the Options bar - it can be turned off by clicking Hide Options.

@ Top level of plan - Mozilla Firefox g@

Fle Edt View Hstory Bookmarks Tools Help  delicious

<;: M T @ @ Ea Tag | L file S iDotuments%20and % 2058ttings User [Deskkopf JUNK/ school %200utcomes%e20madelf: | ~ [ v &,
’ Getting Started (5 Latest Headlines
Norton . (@) tentity safe v =% Log-ns =

School Outcomes Model

School outcomes model

@ Information on the school

Introduction

Bestschoolwe can be ¥ Top level of plan
Walues
Ethical potential
Academic potantisl

Personal potential

Community relationships
Staff capability

Full ethical ﬂ Full academic Full personal
V]

] potantial potential Resource managemant
Community Staff capahility Finances Resource
relationships management

] A | 4

¥ Hide Optians

) How da I use this o L Download " J L Download the Doview

[ Dowrload a POF il of 4 = inernal link, @ = excarnsl link,
Dotiew model? Doiview file of this model g

—
AW e medal now This is a web page version of a DoView model.
. The full model may contain sdditional infarmation, [
< s
Daone zotero

General navigation within a web page model
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Someone browsing a web page model on an intranet or the internet can navigate around the
webpage model as shown in the screenshot below.

comes model
Introduction
ol we can be T Top level of plan
Walues
Ethical potential
Acadermic potential
Personal potential
Cornrmunity relationships
Staff capability
:ademic Full persaonal
ential potential Rl ST s
. 4 4
ad the DoWiew s Downlosd & POF file of _‘_ = internal link, ":"_= axternal Ii_nk.
-iz rmadel & @ thiz model now Thiz iz a web page version of 2 Dr:':'clleeliu
The full model may cantain additi-:unai
information, |
I [

'Page-jumps' within a web page model and external hyperlinks out to external web
addresses

There are two types of hyperlinks which can appear on a DoView page. The first is an external
hyperlink out to any web address on the internet. The second is a ‘page-jump' which takes the viewer
to another page within the same web page model. The icons for these are shown in the screenshot
below.
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School Outcomes Model

Sche

& Information on the school

Full ethical
potential

Downloading DoView and PDF files from a web page model

A unique aspect of DoView web page models is that the original DoView file which created the web
page model can be downloaded from the Options bar at the bottom of the screen when viewing the
web page model. In addition, a PDF of the web page model can be downloaded for those who want
to print out all of the pages in the web page model. The user who created the web page model has
the option of including these two options in the web page model or not including them. For more on

creating a web page model see Section: Web page models (creating). The web page model

download options are shown in the screenshot below.

Full ethical Full academic Full personal
potential potential

¥ Hide Options

a How do I use this Cownload o Cownload the DoView H“g‘ Cownload a PDF file of
DoView L] filz of this model _& this rnodel now

Coview model?
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53

Link out to web or file

Hyperlinks out to external web pages and links to local files on your computer (e.g. Word,
Powerpoint or Excell files) are types of objects which can be put onto a DoView page. Links out to
external web pages (small grey icons) can be used to link out to any web page (URL) on an intranet
or the internet. Local links can be made to any file on your computer (small grey ring). If a local file
can not be found any more, it will be shown with a 'broken' link icon (small grey icon with a cross

through it).

=) =] =]
©@This is alink to an external web page 22 This is a selected linkjo an external web pageZ

@ This is alocal file link @ This is a 'broken’ link to a file which cannot be found any more

Inserting a hyperlink out the web or to a local file
¢ Go to a blank area of a page and do a Right-click > Link out toweb or file

e Push Alt 5.
e Copy an existing link out to web or file (Right-click > Copy), go to where you want the item to be,

and do a Right-click > Paste.

The dialog box below appears when a link out to web or file is first created. Put the name of the link
you want to appear on the top line and the address of the hyperlink on the second. To insert a link to
a local file click on Browse and select the file.

-

&% Edit link information =

Mame: [This iz a link out to @ web page or local file ]

Address: [htu:l:ﬂwww.awebpage.mm ] [Erugvse...]

Double clicking on a web link or local file link on a DoView page will take you to either the external
web address (URL) or it will open the local file on your computer (you need to have the relevant
software installed to open the file e.g. Excel to open an Excel file.

Right-clicking on a selected or unselected web or local file link gives the following menu which allows
you to do things with the link.
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= - a g
3D This is a web ligk or lopalfilatink
Rotate ,

Open Link...
Edit Details. ..

Copy
Delete
Format 3

Show Details b
Set page jump...

Edit Details is used for editing the address and name of the web or local file link.

Including a page-jump with a text object
Text objects can have page-jumps associated with them. These are small triangles which allow you
to jump to another page.

In contrast to other gbjects in DoView (text, indicators, evaluation questions, items), double clicking
on a hyperlink does not allow you to edit it directly (because it takes you out to the external web
address or opens the local file).
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Import-Export

The following can be used for getting information out of DoView (and in some cases into DoView):

Pages can be moved between instances of Doview by using copy and paste in the page list (see
Section: Pages, copying between models).

All pages in a model can be transferred out of DoView by selecting each of them separately and
pasting them into external software such as Word, Powerpoint or Outlook® (see Section: Copying
pages). For better quality images in Word or Powerpoint, first create PDF of the pages you want
to put into Word etc. Then select the page within your PDF software and Paste Special into Word
or Powerpoint.

All of the pages in a model and all of the contents of the details-table can be printed to PDF (see

Section: Printing as PDF file).
All of the pages in a model can be turned into a web page model which can be put up on an

intranet or the internet (see Section: Web page model (creating).

The information in the Details Table can be exported as a CSV file File > Export to CVS. This file
will be able to be read by Excel.

Text within objects (steps, text, indicators etc.) can be copied and pasted back and forth between
DoView and external software using a Right-mouse click.

A DoView file can be saved in XML format which can potentially be accessed by some other types
of software if it was explicitly set up to import the XML file produced by DoView. See the Section
on File formats & XML
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55.1

Examples of use

This section provides examples of the ways in which DoView can be used as follows:

You should also see the DoView Video Tour Quick Examples Tour (select Help > Tours from the
main menu).

Strategic plan

e Qutcomes model

e | ogic model

Strategy map/Balanced Scorecard
Evaluation & monitoring plan
Stakeholder plan

SWOT analysis

Strategic plan

DoView can be used for high level strategic planning. Stakeholders often find it easier to think about
their high level objectives when they are \visuallized as outcomes within a DoView model. DoView
can also be used for specific tasks within strategic planning - stakeholder planning and SWOT*
analysis. The steps for dewveloping a strategic plan in DoView are as follows:

1. Draw an outcomes model
For information on how to build an outcomes model see the Section on OQutcomes models. You can
also find examples of outcomes models you can borrow to use yourself at Qutcomesmodels.org.

2. Mission and vision

The top levels of your outcomes model make up your vision and mission. You may want to write
these out separately as in a traditional vision and mission statements, or you might be happy with
the way they are visualized in your DoView model without having to have a separate vision and
mission statement. If you want to simply use the DoView approach, print the high level pages out
using print as PDF and use them as your high level vision and mission statement (you can put them
up on the wall as you would a vision and mission statement if you like).

3. SWOT and stakeholder analysis
You can use DoView for various types of analysis. For example, SWOT analysis and Stakeholder
planning.

4. Priority setting

Get agreement of your internal and (as appropriate) external stakeholders for the priorities for your
organization in the next planning period. You can mark these on your DoView model by making
priority steps different colors (e.g. using the three different shades of blue to show priority) or you
can just put numbers (1,2,3 priority) or letters (A,B,C priority) into the relevant step.

5. Show which activities contribute to which steps and outcomes

You can create steps for each or your organizational or project activities and then make links
between these and the steps and outcomes in your model which that particular activity contributes
to. Then clone them onto a larger page and draw in the line and arrow links. This will give you an
oveniew of why you are doing what you are currently doing. It can also be used to think about the
priorities for action in the future.
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* Strengths, Weaknesses, Opportunities and Threats analyses used in strategic planning.
g

55.2 Outcomes model

DoView is designed to help you quickly build large or small outcomes models. Outcomes model go
by different names including: logic models, intervention logics, program theories, theories of change,
results chains, strategy maps, cause-effect models, etc. The name ‘outcomes model' is a generic
term for any model that shows the causes and effects (steps) that lead to high level outcomes.
DoView is purpose built software (as opposed to generic drawing software) which has been designed
to help you build and work with such models efficiently. Once you have built your outcomes model
for your project, organization, collaboration, joint-venture or sector, you can use it as the basis for
many areas of organizational life. See the DoView approach for a brief discussion of the ways in
which you can use a DoView outcomes model.

To build an outcomes model:

1. Identify the high level outcome or outcomes you want to achieve and enter them as steps on a
DoView pages . If you are drawing a ding a Bottom-to-Top model you can put your highest-level
outcomes along the top of a page and the steps needed to achieve them below. If you are building
a Left-to-Right model you can put your highest-level outcomes on the right-hand side of the model
and the steps which are needed to achieve them on the left. For a set of guidelines on building
outcomes models see the Section Outcomes model guidelines

2. Progressiwely put in the lower-level steps that need to be achieved in order to make higher-level
outcomes happen. If you need more than one page, drill-down to lower level pages to put more
detail about particular steps on those lower-level pages.

3. Put in links between lower-level steps and the outcomes above them which they make happen (in
those cases where it is not visually clear which steps lead to which or where you want to store
additional information (e.g. evidence) about the links). (See the Details-Table Section).

4. In larger models, containing many pages, you can make links between outcomes on different
pages (See Section on Links).

5. Enter any additional information you have into the details table in rows associated with steps or
links in your model.

Adding indicators and questions:

If you want to, you can add indicators or guestions (e.g. evaluation or research questions) and place
them on a page near by the outcomes they apply to. For more information on using DoView to
produce an evaluation plan see the Evaluation Plan Section.

The example below shows two pages from outcomes model for a Green Houses - an
Environmentally Sustainable Houses Project.
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Green Housing Project - Outcomes

-
More environmentally
sustainable houses

[

Sustainable materials . Builders use more al_
more affordable sustainable building 2 '!‘
8

techniques

More sustaninable
materials available

L = L ‘& J
Increased demand for Builders improve their & .
sustainable materials sustainable building

techniques
L = - < J
Home buyers have o Epe Architechs have increased Builders have increased
increased understanding understanding of m understanding of ord? A
of sustainability sustainablity ] sustainability i
L= L - C }d J

B >y - o
Effective training for ? Increased promotion o -
builders & architechs \, of sustainable building
in sustainable building ;ﬁ e

L J L J

-
Environmentally b
sustainable houses .

doview.com model

program (Green Houses) -

U

Top level of outcomes model - clicking on a'page-jump' jumps to the drill-down page below

Home buyers have increased understanding of sustainability

Home buyers have "o Ee
increased understanding
of sustainability

Sufficient point of Sufficient general Sufficient promotion
sale information media coverage of and linking to
sustainablity “Sustainable
House™ Web Site
Sufficient contact Sufficient contacts “Sustainable
with new home and built up within the House”
building supply media Web site developed
retailers
Point-of-sale Media stories and “Sustainable
information released prepared House" Web Site
prepared planned

Accurate research
on best media
channels for home
purchasers

DoView com model

Drilled down page - which shows more detail of the model

55.3 Logic models

A logic model (program logic) is a type of outcomes model which usually divides the elements in a
model up into a set of levels. These may include: outcomes, goals, missions, intermediate
outcomes, outputs, activities, tasks, drivers, key drivers, causes, effects, priorities etc.
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So as to provide the most generic approach possible, DoView refers to all of these as just steps.
They are all steps in causal processes leading from the initial steps right through to the final
outcomes (outcomes are also just entered as steps) which are the end result of the causal process.

If you want to structure your outcomes model, a traditional logic model (program logic) such as one
below which has four lewvels - inputs, outputs, intermediate outcomes and final outcomes - can be
drawn in DoView. This is done by putting all levels in as steps and differentiating between with labels
put in as text objects.

Logic model high level - Sustainable Housing Program (Green House)

Inputs Activities Outputs Intermediate outcomes Final outcome
Sufficient funding Consultation with Home buyer sustainablity

sustainability experts and awareness campaign
. building professionals |
and reguiators

Increased Home buyers Increased
promation of have demand for sustaninable
sustainale increased sustainale materiale
building understanding materials available and
of sustainability ) | affordable
Appropriate office faciliies Information callected on Teaching resources for
sustainable building building professionals
5 materials and techniques > wainingcourses
. Hore
Sufficiently skilled Information collected Advocacy coalition environmentally
program staff about best established to push for sustainable
communication channels . reguiatoryimprovement ||
for home buyers, building >
professionals, regulators
Effective Architechs and Builders Builders use
training for builders have improve their more
builders & increased sustainale sustainable
architechs in understanding building building
sustainable of sustainablity techniques . techniques
Suficiently skilled I e ST " building 1
program staff awareness campaign
Information callected an Teaching resources for
sustainable building building professionals
| materials and techniques . training courses
Home buyers Builders use
more
increased sustainable
understanding building
of sustainability techniques
Information collected Advocacy coalition
about best establishedto push for
communication channels . reguiatoryimprovement — —

for home buyers, building
professionals, regulators

doview.cam model

55.4 Strategy map/Balanced Scorecard

Strategy maps are another type of outcomes model developed by Kaplan and Norton*. Strategy
maps are usually structured into the four levels used in Kaplan and Norton's Balanced Score Card
approach.

The example below shows part of a strategy map for a Green House - Environmentally Sustainable
Houses Program. It has been divided into four levels which have been entered as text objects (the
text has been resized as large) with rule lines between them. The elements in the strategy map have
been entered as steps. The bottom right green step has been selected and so you can see the links
between this and two other steps in the strategy map in the '‘Customer perspective' layer. If the user
wished, they could enter information under such links in the strategy map into the details table row
associated with the link.
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Strategy map - Green Houses

Financial perspective

Customer perspective

Internal perspective

Learning perspective

Work within budget

Provide quality
information in
appropriate media
channels

. Efficient work practices .

Clear strategic
priorities and
accountabilities for staff

Aftract at least $1M
additional funding per
annum

Quality and responsive

relationships with
stakeholders

Implement quality IT
platform for
relationship

management

. Provide media training .

& other professional
development for staff

DoView.com model.

* Kaplan, R.S. & D. P. Norton (2004) Strategy maps. Boston: Harvard Business School Press.

Evaluation & monitoring plan

DoView is ideal for building monitoring and evaluation plans based around a visual outcomes model
(logic model). There are great advantages in having all the information in the one place that you need
to discuss your monitoring and evaluation plan with stakeholders. You will find that when you are
using your DoView visual monitoring and evaluation plan in a stakeholder or evaluation team meeting
(DoView has been optimized for use in meetings with a data projector) all the information you will will
just be a click away.

You DoView monitoring and evaluation plan can then become a 'living document' which you keep up-
to-date as a way of controlling the implementation of your evaluation. When you need to report to
stakeholders on how the evaluation is tracking, you just need to either send them a copy of the plan
in DoView, as a PDF, or put the plan up as a web page model.

To build a DoView visual monitoring and evaluation plan

1. Draw an outcomes model using the method described in the Examples of Use: Outcomes Model
Section.
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Evaluation plan - Green Houses

Increased number of environmentally

sustainable houses
A -- .
Increased supply of sutainable Increased affordability of
materials & practices sustainable materials & practices
- r 1 - ¥
| Increased building professionals’ Increased demand for
sustainable practice skills sustainable materials

Increased building 1 Increased home purchaser
professionals’ awareness awareness
Sufficient sustainable practices Increased promotional materials
professional training on sustainable building

Environmentally sustainable
houses program (Green Houses)

DoView.com model

A DoView outcomes model (logic model). This one is Bottom-to-Top, it could be
Left-to-Right.

2. ldentify any indicators (measures of an outcome) and put them onto the model next to the
outcomes they measure. You can erase the drawn lines and arrows from this version of the model
so that you have room to see the indicators. If you make the model out of clones, then if you update
the name of a step in the model, it will be updated in the cloned version immediately.

Evaluation plan - Green Houses

Increased number of environmentally

‘ sustainable houses
[l % of new house meet sustainability witeria
Increased supply of sutainable Increased affordability of

materials & practices sustainable materials & practices
[l Average cost of sustsinable materials

Increased building professionals’ Increased demand for

sustainable practice skills sustainable materials

[} % inzrease in training programs
Increased building Increased home purchaser
professionals’ awareness awareness

[l % awareness on survey {building professionals) [l % issue awareness on survey [home purchasers)

Sufficient sustainable practices | Increased promotional materials
professional training on sustainable building

Environmentally sustainable
houses program (Green Houses)

DoView.com model

Indicators mapped onto the outcomes model (logic model), line and arrow links erased
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If you wish, you can list the indicators by copying and pasting them as clones onto another page.

Indicators List - Green Houses

[ % of new house meet sustainability criteria

D Average cost of sustainable materials
[l % increase in training programs

[ % awareness on survey (building professionals)

DoView.com model.

Indicator list 'cloned' onto another page

3. Identify any evaluation guestions and put them onto the model next to the outcomes they

measure.
Evaluation plan - Green Houses
CE' Did the program . Increased number of environmentally |
increase the number sustainable houses
‘ of sustainable

houses?

) Did the program
increase
professionals’
awareness?

@ 1s the current
amount of
professienal

training sufficient?

Increased supply of sutainable "

Increased affordability of
materials & practices

sustainable materials & practices

Increased building professionals’ ]‘

Increased demand for
sustainable practice skills

sustainable materials

v @ Did the program

Incrgased.bundmg Increased home purchaser increase home
professionals’ awareness awareness purchaser
awareness?

Sufficient sustainable practices H

Increased promotional materials
professional training

on sustainable building

Environmentally sustainable
houses program (Green Houses)

DoView.com model

Evaluation questions mapped onto the outcomes model (logic model)

If you wish, you can list the evaluation questions by copying and pasting them as clones onto

another page.
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Evaluation question list - Green Houses

€D Did the program increase the number of sustainable houses?
€D Did the program increase professionals’ awareness?
15 the current amount of professional training sufficient?

@ Did the program increase home purchaser awareness?

DeoView.com model.

Evaluation question list 'cloned' onto another page

4. Identify possible, or actual evaluation projects, and put them onto another page in your model
using items to represent them. Put the relevant evaluation questions under them.

Evaluation project - Green Houses

[E] Evaluation Project 1: Quasi-experimental design of Green Houses program run in three localities
compared to three control localities

Notes: This two year evaluation project will require external funding and will be the subject of an
external research funding bid with three other research partner organizations.

D Did the program increase the number of sustainable houses?

[E] Evaluation Project 2: Survey of building professionals

Notes: Before and after survey of building professionals looking at awareness funded from within core
evaluation funding.

€D Did the program increase professionals’ awareness?

@ |5 the current amount of professional training sufficient?

[E1 Evaluation Project 3: Survey of general public

Notes: Before and after survey of home purchasers looking at awareness funded from within core
evaluation funding.

€ Did the program increase home purchaser awareness?

DoView.com model.

Evaluation projects with relevant evaluation questions 'cloned' onto the page

Tip: The notes field of the evaluation project items' row in the details table has been displayed on the
page (Right-click > Show Details > Notes). Only one field from an object's row can be displayed at a
time on a page and only certain objects (items, indicators, questions) can have fields displayed on a
page in this way.

5. If you wish, you can also use DoView to build a simple project plan on another page for each
actual evaluation project you are planning to undertake.
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Project Green Evaluation Project 3: Survey of general public

[©] Evaluation Project 3: Survey of general public
Notes: Before and after survey of home purchasers looking at awareness funded from within core evaluation funding.
(@ Did the program increase home purchaser awareness?

|dentify possible survey companies - March 20

Identify sample frame - June 20

Identify survey questions - June 20

Finalize questions & sample farme with survey company - July 1
Sign off for survey to go into field - July 17

Review draft report - November 1

Receive final report - December 20

Start discussing report with decision-makers January-March.

DoView.com model.

Small project plan for evaluation project

55.6 Stakeholder plan

DoView can be used to visualize where stakeholders stand on the dimensions of influence and level
of support when this type of analysis is used in strategic planning. (Or other dimensions if you want
to). See the Examples of Use: Strategic Plan Section on how to use DoView to build a strategic
plan.

In the example below, stakeholders have been entered as items onto a page. Additional information
about a particular stakeholder can be entered into the row of the details table associated with the
item which represents the stakeholder. Or a page-jump could be put under each stakeholder so you
could jump out to a page which provided more details on them.

In a strategic planning meeting, stakeholders can be dragged around the page to the point which
best shows where it is believed they are positioned in terms of influence and level of support.
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Stakeholder plan - Green Houses

Currently less supportive Currently more supportive

[l Land Developers

Association [l Environmental = Architects®
i Protection Agency Association
Currently high [E Professional Builders’
influence Association _ -
B Chamber of as 'tems’
Commerce
| |ati
Dgus;pelni;?g [E Green Building
Suppliers
[] Sustainable Business
Association
Currently low [ Green Political

Party

[ Local University
Urban Planning
Center

influence

DoView.com model

55.7 SWOT analysis

DoView can be used to do a SWOT (Strengths, Weaknesses, Opportunities, Threats) analysis as
part of strategic planning.

In the screenshot below, the headings for Strengths, Weaknesses, Opportunities and Threats have
been put on a page as text objects with large text size (Right-click > Change Size > Large). Under
each heading, items have been used to put the Strength, Weakness, Opportunity or Threat onto the

page.
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SWOT strategy analysis - School

Identifying Strengths, Weaknesses, Opportunities and Threats Analysis

Strengths

[ Good teaching staff

[0 Good relationships with community

Weaknesses

[l Relatively small schoal
[E Hard to attract staff

Threats

[E1 Mew school opening in the area
[E1 Schoal facilities seen as old

Opportunities

[E Growing parent concern about
children’s grades

[0 Passibility of building on adjacent
land

DoView.com model.

The second stage of a SWOT analysis tries to identify strategies which are able to address the four
possible combinations of strengths, weaknesses, threats and opportunities. DoView can be used to
model this as in the screenshot below. The items from the page with the SWOT analysis above have
been cloned onto another page, their size has been reduced to small (Right-click> Change Size >
Small). The strategies have been entered as items.

SWOT strategy analysis - School

|dentifying strategies which meet Strengths, Weaknesses, Opportunities and Threats

Strengths

[l Good teaching staff

Bl Bood relationships with
community

Weaknesses

Eﬂ Relstively small school

|:|] Hard to atiract staff

Threats

E‘] Mew school opening in the area
|:|] School facilities seen as cold

[E Set up ‘Friends of" group for school
drawing on local community
contacts

[E Promote school as being a child
friendly teacher friendly small
cottage schoaol

Opportunities

El] Growing parent concern about children's
grades

[l Passibility of building on
adjacent land

[ Set up campaign to support
building on adjacent land

[E Investigate research an size of
school and student outcomes

DoView.com model.

Tip: If there were a lot of Strengths, Weaknesses, Opportunities or Threats, one page could be used
for each of the four possible combinations of Strengths, Weaknesses, Opportunities and Threats.
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56.1

Building outcomes models

This sections sets out information about building outcomes models. It goes beyond the rest of the
information in this Help Documentation which is about the technical aspects of using DoView as a
piece of software. The suggestions in this section apply to any outcomes models you build
regardless of whether or not you use DoView to build them.

Different people have different approaches to building outcomes models. Some have rules about what
you can and can not put into outcomes models. DoView is flexible enough to be able to
accommodate any approach you may wish to use, or which you may be required by others to use.

Howewer, having built many outcomes models in many different areas, at DoView we have a number
of suggestions abut how to make your models better and these are set out in this section.

e Building good outcomes models - a set of guidelines for creating well constructed outcomes
models which can be used for many purposes (strategic planning, priority setting, monitoring,
evaluation, research and dewvelopment planning, contracting and other aspects of organizational
life).

e DoView model conventions - some suggestions for conventions to use when building DoView
models.

e Why vou should use compact pages - the advantages of building your models in compact pages
ewven if you also clone them to one or more large pages for printing to ledger/A3.

e What is an outcomes model? - why DoView keeps things simple by referring to all elements in an
outcomes model simply as outcomes at various lewels rather than requiring you to have work out
exactly what type of element you are dealing with (e.g. goals, missions, intermediate outcomes,
outputs, activities etc.)

¢ Non-siloed outcomes models - explaining why it is an important feature of DoView that it lets you
link any outcome to any other outcome and it lets you clone outcomes, which awids you being
forced to just drill down in single 'silos' under individual high level outcomes as happens with some
other software and database approaches.

e Typical DoView process - summary of the process of meetings etc typically used when building a
DoView outcomes model.

e Using DoView in meetings - how to optimize using DoView in meetings.

e Workflow - Many projects within an organization - discussed how to work in a situation where you
are dealing with multiple projects which are all contributing to one set of high-level outcomes.

e Workflow - OutcomesModels.org - models you can use - a set of outcomes models you can use
is available at www.outcomesmodels.org

Building good outcomes models

DoView is flexible enough for you to build your outcomes models any way you, or those you work
for, want you to. Howeer, to get the most out of the outcomes models you build in DoView (or in
other software for that matter) you might like to look at the guidelines for drawing outcomes models
set out below. In particular, if you draw your outcomes models in this way you will find that they can
be used for a broad range of purposes. Some other ways of drawing outcomes models, for instance
those that demand that you only include outcomes which you can currently absolutely prove you
changed, leads to very limited outcomes models. Such models may be able to be used for
accountability but are not much good for other purposes such as helping you think strategically
about other things you could do or about what you can and what you cannot evaluate in terms of
outcomes. A well built DoView model should be able to help you with strategic planning, priority
setting, monitoring, evaluation, research and development planning, contracting and other aspects of
organizational life.
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Guidelines* for drawing good outcomes models are:

1. Use outcomes not activities as your step names. You can change an activity (doing) into an
outcome (done) by just changing the wording (e.qg. 'Increasing stakeholder support' to ‘'Increased
stakeholder support’).

2. Let your outcomes models include any of the ‘cascading set of causes in the real world'. In
DoView we just refer to every type of cause at whatever level as an outcome. See the What is an
Outcomes Model? Section for the reasons why. The steps that are put into your models do not have
to be limited just to your measurable, attributable (ones you can absolutely prove you changed) or
accountable outcomes. There is usually a lot of resistance to putting in your outcomes models non-
measurable and non-attributable outcomes. This is because stakeholders want to manage their risk
around being held to account for the outcomes that go into such models. This is a genuine risk but
is best managed by dealing with measurement, attribution and accountability after your have built
your base model. For instance, by dealing with measurement by putting indicators onto your model
(doing it this way lets you see which outcomes you do not yet have indicators for); by dealing with
attribution by going through later and marking those steps which are attributable to a particular
player (you could do this with color, brief letter codes, or put the player in as a step and making
links between them and all of their attributable indicators); and by dealing with accountability by also
going through later and marking those steps for which a particular player is going to be held to
account (or contracted to do).

3. If you are not required to by others, do not force your outcomes model into particular horizontal
levels' within the model such as inputs, outputs, intermediate outcomes and final outcomes. It is
possible to do this in DoView if you want to (e.g. see program logic and strategy maps), however in
some cases it may distort a good clear visualization of the flow of causality in the real world. For
instance, some types of outputs (for instance) may reach further up one side of an outcomes model
than another. Forcing artificial horizontal layers onto an outcomes model often distorts it and makes
it harder for stakeholders to ‘read’ the logical flow of causality in the model. The concept of outputs
is useful for accountability purposes and they can be identified later at whatever level of a model they
are located by going through and marking them with color or brief letter codes.

4. Do not 'siloize' your model. Silozing is when you draw an outcomes model in a way that artificially
forces lower level outcomes to only contribute to single separate high-level outcomes. In the real
world, good lower level outcomes can contribute to multiple high-level outcomes. Any outcome can
potentially contribute to any other outcome in a model, the way you draw the model should allow for
this. In contrast to may other software visualization and database approaches DoView never forces
you to siloize your outcomes model. Any outcome (step) can be connected to any other outcome at
any lewvel through using linking.

5. Use 'singular' not ‘composite’ outcomes. Composite outcomes contain both a cause and an effect
(e.g. increase seat-belt use through tougher laws). This should be stated as two, rather than just one
outcome. Words like through, or by in an outcome show that you are looking at a composite, rather

than a singular outcome.

6. Keep outcomes short. Outcomes models with wordy outcomes are hard to read. To help you do
this, DoView lets you include separate descriptive notes in rows within the details table where you
can put as much detail as you like about any outcome (step).

7. Put outcomes into an hierarchical order. The normal DoView convention is to have highest level
outcomes at the top and then drill down to lower level outcomes. Use the simple rule that you can
tell that outcome A is above outcome B in a case where, if you could magically make A happen, you
would not bother with trying to make B happen.
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8. Each lewel in an outcomes model should include all the relevant steps needed to achieve the
outcome(s) abowe it.

9. Keep measurements/indicators separate from the outcomes they are attempting to measure.
Measurement should not be allowed to dominate an outcomes model. If it does you are drawing a
model of what you can measure, not what you want to do. Using DoView measurement can be
introduced at a later stage by putting indicators onto a page. In those relatively small number of
cases where a measurement also acts as an intervention in its own right (e.g. some audit
procedures), then it can be included as an outcome (step) within a model.

10. Put a value' in front of your outcome (e.g. suitable, sufficient, adequate). You do not need to
define this at the time you first build your outcomes model. If it is not clear exactly what it amounts
to, it can become the subject of an evaluation project later on.

11. Dewelop as many outcome pages as you need (but no more). In an outcomes model you are
trying to communicate to yourselves and to other stakeholders the nature of the world in which you
are trying to intervene. Pages can be seen as a series of cuts through the world of outcomes in your
area of interest. For instance you might have pages at the national, locality, organization and
individual lewvel. The trick is to get the smallest number of pages needed to effectively communicate
the relevant outcomes in the model. DoView lets you quickly move through your pages once you
have built them with page-jump hyperlinks.

12. Do not assume that you need a single high-level outcome at the top of an integrated
organizational outcomes model. Outcomes models should be about the external world, not just
about your organization. Often organizations are delegated to undertake interventions in a number of
areas or sectors that are best modeled separately. If you build separate models for the conceptually
different areas or sectors you are intervening in, you can then just take that specific model and use it
in discussions with stakeholders from that sector. This keeps things really clear for external
stakeholders as the specific outcomes model which they are interested in is not enmeshed with
other outcomes from other sectors they are not interested in. In addition, if you have drawn your
models as generic ‘cascading sets of causes in the real world' as suggested in 2 abowe, rather than
restricting them only to outcomes which are attributable (ones you can absolutely prove just you
changed) to you, you will find that they make a lot more sense to external stakeholders. External
stakeholders can then just map onto the outcomes model the particular outcomes they are focusing
on.

13. Include both current high-priority and lower priority outcomes. Your outcomes model should be
as accurate a model as you can draw of the ‘cascading set of causes in the real world’ therefore it is
not just about the current priorities you can afford to work on if they are a sub-set of the wider
outcomes picture. Once you have drawn your outcomes model you can then map a typically more
limited number of priorities onto your more comprehensive outcomes model. This allows you to think
strategically about alternative options in the future and reflect this by changing your priorities. If your
outcomes model only includes your current priorities it gives you no steer as to how your current
priorities map onto the real world. In a public sector context this also allows outcomes models to
support public sector employees providing ‘free and frank advice’ about how the world is —i.e. the
cascading set of causes in the real world. It is also consistent with the idea of evidence-based
practice. It is then up to elected government officials to decide what their priorities will be and these
can be mapped onto the underlying outcomes model. This approach means that outcomes models
do not have to change every time there is a change in the elected official in charge or of the
government as a whole. If elected official priorities change they are simply mapped onto the more
comprehensive outcomes model.

* Based on Duignhan, P. (2008). Standards for draw ing outcomes models. Outcomes Theory Know ledge Base Article
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56.2

56.3

No. 210. [http://knol.google.com/k/paul-duignan-phd/standards-for-draw ing-outcomes-models/2m7zd68aaz 774/28].

Suggestions for laying out models

Outcomes models can be visualized in different ways..Some suggested visual conventions for
drawing outcomes models in DoView are set out below if you are representing your models as a

Bottom-to-Top model:

¢ Put your highest level outcomes at the top of a page and lower level outcomes below them. This is
consistent with outcomes orientated thinking because it makes the high level outcomes the most
prominent part of the model. It is also convenient because you usually have more lower level
outcomes in a model than high level ones and these can spread out over more than one page,
using drill down below a high level page containing your high level outcomes. You can insert a
direction pointer to show the direction in which the model is flowing.

¢ For outcomes that affect many levels of other outcomes, put them down one side of the model by
rotating them to show that they ‘flow-over' the whole model.

¢ Do not put measurements (indicators) in as steps within your outcomes models, put
measurements in as Indicators.

¢ Use colors to help readers understand an outcomes model (e.g. by using it to signify different drill-
down pages.

¢ Use the color of the color blocks next to page names to also help readers understand how your
model flows. See Section on Pages.

¢ Use positioning of outcomes to visually show causality.

¢ Use different pages to show outcomes which are conceptually connected, for instance, have a
page for national, locality, organizational and individual level.

¢ Put the date and version number in small text at the bottom right of your page.

Why you should use 1 x1 pages

DoView lets you use a range of page sizes.

Howewer, there are a number of advantages in using the default compact 1 x1 pages when you first

build your mode. If you build a model using compact 1 x1 pages you can, if you wish, also clone all
of it onto one or more larger pages so that you can print it in larger printed poster formats. See the

Section on Clones for more information.

The advantages of using compact 1 x 1 pages are as follows:

e Compact 1 x1 pages can always be viewed on a dataprojector. The philosophy behind the DoView
approach is to build a comprehensive outcomes model (program logic, strategy map, results chain
etc) which can be used for integrating all aspects of organizational or project life - strategic
planning, monitoring, evaluation, contracting etc. This means that the model needs to be able to
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be used in all important meetings and amended in real-time in such meetings.

¢ Breaking your model up into compact 1 x 1 pages encourages a modular approach to outcomes
model (program logic etc) development. Such a modular approach breaks an outcomes model up
into pages such as a national, local, institutional, individual etc level. This approach increases
efficiency because you can borrow modules from other outcomes models which you can then
amend and fit into the model you are working on. Once you have built your outcomes model you
can then take modules from it and you, or others, can use them in subsequent models in the
future. Models from which you can borrow some or all pages are available at www.
outcomesmodels.org.

e Compact pages can be emailed to anyone and viewed either on screen or printed as either a PDF
produced by DoView (See Section on Printing as PDF file) or as a DoView file for those who
already have DoView or who want to download the DoView 30-day free trial. Being able to share
outcomes models with all of your colleagues is another aspect of the DoView approach.

What is an outcomes model?

An outcomes model is simply the ‘cascading set of causes in the real world' which lie behind any
outcome occurring.

A range of different terms are used in strategic planning, project planning, program logic and
outcomes models for the elements which can go in these models: These terms include: outcomes,
goals, missions, intermediate outcomes, strategies, outputs, activities, tasks, drivers, key drivers,
causes, effects, priorities etc.

Many type of strategic planning software hard-wire these terms into their structure. As a result,
many normal users spend a lot of time trying to work out whether something is an activity or an
intermediate outcome, or an output or a whatever.

The DoView approach is to keep it all very simple and is based on the belief that all we are talking
about here is a set of things causing other things. At the top we have some outcomes and all of their
causes, from those at the very bottom, which make them happen. To keep it really simple, DoView
just calls all of these steps which lead to outcomes at the top.

The technical reason for calling them all outcomes is that the distinction between an outcome and
lower lewvel steps is often a relative one. An outcome for one organization may be a strategy step for
another organization. The DoView approach is to draw outcomes models which are about the real
world, not just about organizations. This makes such models much more useful for a wide variety of
purposes.

There is no reason why, after you have built a DoView model, you can not go through the model and
identify elements in it for particular purposes. For instance you might want to go through and identify
all those which are outputs for a particular party (color them, or put a text code in them, or link the
particular player to them). (Outputs are easily measurable actions that players take and which they
are held to account for doing).
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56.5

56.6

Non-silioed outcomes models

DoView lets you build 'non-silioed' outcomes models. Have you have ever been frustrated working
with a strategic planning or other outcomes system which forced you to enter an activity or task
under just a single higher level outcome? If so, you were up against a system which demanded a
'silioed' approach.

The purpose of building good outcomes models is to try to realistically model the pattern of causes
and effects in the real world which lie behind your project, program, policy, organization, joint-venture
or sector. Software or database approaches which force you to build a 'silioed’ model force you to
distort the reality you are working with. Users often have to respond to such artificial restrictions by
putting in the same, or sometimes differently worded, but similar, lower level outcomes under a
number of the higher level outcome silios. This is inefficient and creates confusion for those viewing
the model.

In contrast, DoView lets you link any lower-level step to any number of higher-level outcomes within
a model and so lets you create non-silioed more realistic models. When your models include more
than one page (which is often the case) DoView lets you place clones (live copies’) of any of your
outcomes on any page. When it comes to updating an outcome, the name, row in the details table
and links of any clones of the outcome you are updating are all updated automatically right across
the model.

Typical DoView process

This section sets out a few suggestions about the process of working with a group or organization in
building an outcomes model using DoView. These suggestions come from building a large number of
models for different organizations in different sectors using DoView.

A typical DoView outcomes model building process can go as follows:

¢ Meet with those commissioning the work and tailor the following process to the particular program,
organization or sector.

e Meet with a wider group of stakeholders and explain how the process is going to roll out. Show
some examples of DoView models. Get initial input on the process. Discuss the DoView
suggestions for building good outcomes models (See Building Good Outcomes Models Section).
(Say a 1-2 hour meeting).

e Work with a smaller group to build the initial draft of the outcomes model. Have in the room the
highest lewvel stakeholder you can, one person who knows how to work DoView and draw DoView
models. Seweral people who are subject experts. Try to keep this group reasonably small. (Say
four 3 hour meetings). Get participants to bring to the meeting any documents which set out
outcomes of any type or the program, organization or sector. Building outcomes models can be
rather intense work so 3 to 3 1/2 hours is usually about the right length of time.

e Take the draft model back to the wider group of stakeholders. Make sure the members of the
smaller group attend this stakeholder meeting (they will be able to explain some of the decisions
which have been made in building the draft model).

e Reconvene the small group to look at the feedback regarding the model and to amend the model
as appropriate.

e |f appropriate, start work on identifying indicators and evaluation questions if this is part of what
you are planning to do.

e Appoint someone to be the 'Keeper of the model' who will keep it up to date and maintain it over
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time. They can keep the Master copy of the model and send out copies for others to look at and
use in DoView on their own computers.
¢ Hawe the small group reconvene from time to time to make sure that the model is still up to date.

Remember

e There are usually a number of good ways of drawing a DoView model. You do not have to get THE
right way of drawing the model, just one of the good ways of drawing it.

e There are 'lumpers' and 'splitters' in the world. Lumpers will want to lump outcomes together and
splitters will want to divide them up into smaller and smaller outcomes. Generally let the splitters
do a little more splitting at the start of the process because you can always lump outcomes
together later on.

Using DoView in meetings

The DoView approach is that a comprehensive electronic version of an outcomes model (strategy
map etc) should lie at the center of all program and organization life. The same basic outcomes
model should be used for strategic planning, priority setting, monitoring, evaluation, reporting,
research and dewvelopment planning, contracting and other aspects of organization life. Such models
need to be well constructed and they should be visualized in software in such a way that they can
be used in real-time during any important program or organizational meetings.

Users often build large outcomes models with other types of software which they can read at the
resolutions normally used on desktop PCs or when printed out on large pages (such as ledger/A3).
Such models can be built in DoView if the user wishes. However, when such models are used in a
meeting with a data projector, meeting participants often cannot read the detail in the models. This
happens because of the combination of data projectors' resolution (often 1024x768) and the physical
size of the typical data projector screen which is used.

DoView has been designed to make sure that, as far as possible, all the details of any DoView
model (when built using compact pages) are clearly viewable when used with a data projector at
1024x768 resolution on a typically-sized physical data projector screen in a medium sized meeting
room. (See the Section on Why You Should Use Compact 1 x1 Pages for more information, and
note that you can clone a copy of your model made in compact pages to a larger poster size pages
whenever you wish.

This enables the electronic version (rather than just paper printouts) of a DoView model to be studied
and amended in real-time within a meeting. If the screen is too small in a very large conference room
then the model will not be able to be viewed properly.

If using DoView with a data projector you should check that the data projector is set at a 1024x768

resolution. This will make sure that the details of the model as large as they can be on a data
projector screen. See the Section on Screen resolution for more information.

Workflow - Many projects within an organization

If you have many projects within one one program or organization your workflow for using DoView
can be as follows:

1.Develop high-level outcomes diagrams (outcomes models)
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A set of high level outcome diagrams could be build by senior management and those doing
strategic planning (let's call them the Strategic Planners for the sake of the discussion here) for your
overall program or organization. In addition to the high level outcomes diagrams in this model, there
should also be a diagram listing all of the projects within the program or organization. The project
names can just be entered as steps (you may like to put '(P)' in front of them so you can recognize
them as steps later on. You can fit thirty or so of these onto a single compact diagram (page) and
can include more than one page if you have more than thirty projects. This Program or Organization-
Wide High-Lewvel Outcomes Diagram (Model) which includes the high-level outcomes diagram and
also the project should be held and maintained in a single DoView file by one person in
management or planning (e.g the Strategic Planner). You should think of it as being like a software
spreadsheet, there needs to be someone who holds the master copy to make sure that it is kept up-
to-date and maintains its integrity. This Program or Organization-Wide High-Level Outcomes model
can be turned into a web page model (File > Create Web Page Model) and put up on your organization's

intranet or on the internet (see Section: Web page models (creating).

2. Individual project DoView models

Each project team then dewelops its own DoView model which just contains diagrams at the project
level (typically this might be 4 or so pages - perhaps more). The diagrams for each project can be
held in separate DoView files. This file should be held and maintained by someone in the individual
project team - let's call them the Project Team DoView File Holder. Each project set of outcomes
diagrams can be turned into a web page model (File > Create Web Page Model) and put up on your
organization's intranet or on the internet (see Section: Web page models (creating). This project-level
model should be held by someone who we can call here the Project Team DoView File Holder.

3. Linking projects to high-level outcomes

When thinking about the high level program or organization-wide outcomes each project is
contributing to, these should be mapped onto the Program or Organization-Wide High Level
Outcomes diagram. This can be done in various ways. The first option is for the Strategic Planner to
meet with each project team and in such meetings link the particular project to high level outcomes
within the DoView file held by the Strategic Planner (1). This approach has the advantage that the
Strategic Planner can query the project team to make sure that they they are only showing links to
high-level outcomes which can be justified. The second option, is for the Strategic Planner to create
a web page model which they can put on the organization's intranet or the internet. If there are a
number of steps and outcomes, they could be numbered and the individual project teams would just
need to let the Strategic Planner know which steps and outcomes their project is aiming to
influence. A third option is for the Strategic Planner to just email project teams a PDF file of the
Program or Organization-Wide High Level Outcomes model (DoView has built in support for printing
to PDF), they could print it out and simply mark with pen those outcomes in the model their project
is contributing to. They could then fax this marked-up printout to the Strategic Planner who could
then enter it into the master copy of the DoView file which contains the Program or Organization-
Wide High Lewvel Outcomes diagram. The fourth option is for the Strategic Planner to email out the
Program or Organization-Wide High Level Outcomes model to someone in the project team who is
familiar with using DoView and get them to put in the links (e.g. the Project Team DoView File
Holder) as long as they are confident that they will not introduce mistakes into the master file.

Once the Strategic Planner has the master file, with the programs linked to high-level outcomes,
they could record in each step box for each high-level outcome the number of projects which link to
it. This provides a visual way of seeing how program or organizational projects map onto high level
outcomes. If they have put '(P)" in front of each project, when they do a right-click on an outcome and
select Thisistheresult of they will be able to see the list of all project which it is believed will
influence this outcome. This approach can be used when doing strategic planning to identify
outcome areas which few, or no, projects may be aimed at.
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4. At any stage either the Strategic Planner or the Project Team DoView File Holder can circulate
copies of their DoView file to anyone else (e.g. because some other part of the organization wants to
see how they hawe laid out steps and outcomes for a particular project). Howewer, these would
always just be copies of the master file and it should be made clear to everyone that the Strategic
Planner or the individual Project Team DoView File Holders are the ones who hold the master copies
of the files. Any amendments which have to be made to these files would all go through either the
Strategic Planner or the individual Project Team DoView File Holders so as to make sure that the
master copies of the files are always kept up-to-date. One of the easiest and safest ways of letting
anyone get hold of a copy of a DoView file is to create a web page model and select the option to
include a copy of the original DoView file in the model and put the web page model up on an intranet
or the internet. Then for anyone who has DoView installed on their computer all they need to do is
click on the Download the DoView file of thismodel in the Option bar at the bottom of the web page
model and a copy of the file will open in DoView on their computer. See the Section: Web page

models (creating).

[1] Itis possible to do this remotely using an internet service which lets project team members view the
Strategic Planner's screen showing them making the links on their copy of DoView in the course of a
conference call (one such service is called Glance - www.glance.net, it can also now be done on some
versions of Skype).

56.9 Workflow - OutcomesModel.org - models you can use

A range of outcomes models (diagrams) on different topics and from different sectors is available at
www.outcomesmodels.org. They are available in both DoView file format and in PDF file format (for
anyone who does not have DoView yet). These are covered by a Creative Commons license which
means that you are free to use them for most commercial or non-commercial uses without charge
as long as you acknowledge their source. You can use then in the following two ways:

You can use them for ideas for outcomes models (program logics) you are drawing. The easiest
way, if you have DoView installed on your computer is to simply click on them on www.
outcomesmodels.org and they will open within your copy of DoView, then use this file to either build
your model or copy and paste whatever components of the model you want into the DoView file in
which you are building your model.
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57 Installation and technical

This section provides installation and technical information as follows:
e Installing & uninstalling - information on installing and uninstalling DoView.

e Specifications - requirements of computers running DoView.
e File formats & XML - information on file formats and XML.

57.1 Installing & unstalling

Installing

DoView can be installed by downloading the installation file from www.doview.com and running
through the steps in the standard installation procedure. DoView can be run as a fully featured
demo program for 30 days from the date of download. It will then stop functioning. A license
registration key can be bought from www.doview.com.

DoView for Mac is installed by downloading and dragging to the Applications folder.

If you want another trial period, please contact DoView from the contact form on the DoView
website.

Uninstalling
DoView is uninstalled by clicking on Start > All programs > Doview > Uninstall.

DoView for Mac is uninstalled by dragging out of the Applications folder and into the Trashcan.

57.2 Specifications

DoView has been designed to run on machines meeting the following specifications:

Operating system: PC's runing Windows 2000, XP, Vista, Windows 7

Windows ME, 98 and below are not supported.

Recommended minimum speed: 600 MHz Pentium [l with 128MB installed memory.
DoView for Mac 3.0 requires OSX 10.5 or later Intel Processor.
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57.3 File formats & XML

DoView models (file) can be stored in any one of three formats. Files are saved in these formats by
selecting the Save as type option in the save dialog box when you sawe (File > Save) a DoView model
(file). Later versions of DoView, e.g. Version 3.0 can read files from earlier versions, but earlier
versions (2.0) cannot read files from later versions because new features have been added. DoView
for PC 3.0 can read and edit files made in DoView for Mac 3.0.

The three file types DoView can sawe in are:

e DoView document - native DoView format - native DoView format, small file size, fast to load,
you should usually use this file type.

e DoView XML* document - compressed XML format - XML format relatively small file size (larger
than the DoView document native format) (takes longer to load).

e DoView XML document (uncompressed) - uncompresed XML format - XML format relatively large
file size, you should use this file type if you want to mowe information between DoView and some
other software which you have customized to accept or produce files readable by DoView.

*XML is a standard for information interchange betw een different types of softw are.

57.4 Support

Support for DoView is currently offered through the following:
¢ DoView Help - Main menu Help > DoView Help.

e Quick video tours - Main menu Help > Quick Video Tours.
¢ |nformation on the DoView website.

57.5 Buying DoView
Buying

DoView can be bought by going to www.doview.com.

Download DoView from www.doview.com and purchase a registration serial number which can be put
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into the downloaded version of DoView. The free trial version of DoView and the full version are the
same apart from the free trial version not running after 30 days.
Corporate licenses for multiple licenses are available. See the DoView web site (www.doview.com/

buy.html).
There is a scheme for organizations in dewveloping countries to receive a no-cost license to DoView.

Look at the DoView website for more information.
Registration
Once you have been emailed your registration key (after you have purchased DoView from the www.

doview.com site) you enter it by clicking on File > Register in the main menu, put in your name or
organization name and then put in the registration key.

* This is the current cost of DoView, cost may be subject to change at any stage.

57.6 Troubleshooting

Troubleshooting

1. DoView will not open
Your 30-day free trial may have expired.

Solution: You need to purchase a registration serial number from the DoView web site and enter it
when asked to do so when you attempt to run DoView.

2. DoView runs but cannot open a DoView file with DoView.

You may have an earlier version of Doview and are trying to open a file made by a later version. For
instance, if you have version 2.06 or below and try to open a file made by version 3.0 or above you
will get the following message: '‘Cannot load file 'C:\FILENAME'. It requires at least DoView version
3.0 to open'.

Solution: Get the updated version of DoView from www.doview.com.

3. Cannot draw lines and arrow links

Solution: Make sure that you have selected the Show links and draw lines option from the View menu
(see the Section on Views for Links and Lines for more information) and that you have also selected
the Insert Link, and draw line mode for the Link tool on the toolbar (see the Section on Links and
drawn lines).

4. Making a copy of a page to paste into external file such as Word

In early versions of DoView there was a Copy page tool in the tool bar. This has been replaced by a
right-click on the page name and selecting copy.
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Solution: Select Copy as Image from a right-click on a page nhame and then go to the external file

and paste the DoView page as an image into that file.
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copying slices between 120
multiple open 131
rules for building 162, 170
modularity 165
monitoring plan (example) 154
mowve around view 66
mulltiple projects 168
multi-layered model 39

N -Q-

question 77

Posters 122

printing 122, 125

problems 174

program logic (example) 152
program theory (example) 151
project 79

purchasing DoView 173

navigation 105
between pages (page-jump) 37 - R -

non-silioed models 167

_ O _ real-time use of DoView 168
record table
displaying fields on a slice 115
objects 30 exporting data 115
open 22 redo 22

organizations and DoView 168
orientation of model 62

outcomes model (example) 129, 151
building 162

building good models 162, 170 _ o8
rules for building 162, 170 resize _
resolution

outcomes models screen 168
terminology 166

removing DoView 172, 173
replicant object 60
research question 77
resizable arrow 83

results chain (example) 151
- P - right-align 98

right-justified 64, 109

right-to-left models 62

25
pagfxl page 25 rotate 113
compact page 25 row . 103
enlarged page 25 rule line 72
page list 28

page size 165
page-jump 37
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_S-

saving
screen
resolution

size 107
screen size
Shapes 89
sharing models
show details
size of text

slice
insert image 81

173
107
168
133, 140

115
64, 109

slice viewing area 17

slices
large 66, 105
small font 64, 109
small page list tool bar 25
small text 64, 109

solutions to problems 174
specifications 172
Squares 89
stakeholder plan (example)
starting screen 17
status 87

step
aligning 98
entering 33
insert image 81
rapid entry 33
resizing 98

158

strategic plan 150
strategy map (example) 153

Strengths, Weaknesses, Opportunities & Threats
analysis 159

sub-diagrams 39
sub-pages 39

SWOT analysis 159
table 93
templates - making 85
terminology 166
text 68

64, 109
64, 109

64, 109

text size 64, 109

Theory of Change (example)

thing 79

this is aresult of 41

this makes happen 41

toolbar 22

tracking change 74

traffic lights 87

Triangles 89

troubleshooting

turn on side
object

U -

undo 22
uninstalling
URLs 145
using
DoView in meetings
168

align
format
size

151

174

113

172, 173

168

using DoView

Version 2.0 changes 15

vertical
box 113
object 113
text 113

vertically orientated model 62
view 66

viewing on a dataprojector
views 51

visualizing improvements 87
visualizing links 51, 54

W -

web address 145
web page models
websites - creating

workflow
many projects within an organization

107

133, 140
133, 140
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168
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working with DoView 168

_X -

Zoom

zoom to actual 105
zoomto fit 105
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